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Chapitre 1: Materials 

 

 

 

 Verification by the partial factor method 

 
 
Cf art 2.4.2.4. 
 

Partial factors for materials for ultimate limit states,  c and  s should be used. 
 

The recommended values of c and s for ‘persistent & transient’ and ‘accidental, design situations are given 
in the following table. These are not valid for fire design for which reference should be made to EN 1992-1-2. 
 
For fatigue verification the partial factors for persistent design situations given in this table are recommended 

for the values of c,fat and s,fat. 
 

  
 
 
These values can also be found in the Concrete setup of the National Annex: 
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All factors related to the code are shown in green on the screen. By default, the values of the chosen code are 
taken. 
 
The values for partial factors for materials for serviceability limit state verification should be taken as those 
given in the particular clauses of this Eurocode. 
 
The recommended values of γc and γs in the serviceability limit state for situations not covered by particular 
clauses of this Eurocode is 1,0. 
 

Lower values of c and s may be used if justified by measures reducing the uncertainty in the calculated 
resistance. 
 
 
 
 

 Concrete 

 
 
The following clauses give principles and rules for normal and high strength concrete. 
 
 
 

 Strength (art 3.1.2) 

 
The compressive strength of concrete is denoted by concrete strength classes which relate to the characteristic 
(5%) cylinder strength fck, or the cube strength fck,cube. 
 
The strength classes in this code are based on the characteristic cylinder strength fck determined at 28 days 
with a maximum value of Cmax. 
 
The recommended value of Cmax is C90/105. 
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In certain situations (e.g. prestressing) it may be appropriate to assess the compressive strength for concrete 
before or after 28 days, on the basis of test specimens stored under other conditions than prescribed in EN 
12390. 
 
All values can also be found in the material library of SCIA Engineer: 
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It may be required to specify the concrete compressive strength, fck(t), at time t for a number of stages (e.g. 
demoulding, transfer of prestress), where: 
 

fck(t) = fcm(t) - 8 (MPa)  for 3 < t < 28 days 
fck(t) = fck   for t ≥ 28 days 

 
The compressive strength of concrete at an age t depends on the type of cement, temperature and curing 
conditions. For a mean temperature of 20°C and curing in accordance with EN 12390 the compressive strength 
of concrete at various ages fcm(t) may be estimated from: 
 

fcm(t) = βcc(t) fcm          (3.1) 
 

  with βcc(t) = e
{s[1−(

28

t
)

1
2]}

        (3.2) 
 
where: 
 

fcm(t) is the mean concrete compressive strength at an age of t days 
fcm is the mean compressive strength at 28 days according to Table 3.1 
βcc(t) is a coefficient which depends on the age of the concrete t 
t is the age of the concrete in days 
s is a coefficient which depends on the type of cement: 

= 0,20 for cement of strength Classes CEM 42,5 R, CEM 52,5 N and CEM 52,5 R (Class R) 
= 0,25 for cement of strength Classes CEM 32,5 R, CEM 42,5 N (Class N) 
= 0,38 for cement of strength Classes CEM 32,5 N (Class S) 

 
The type of cement can be chosen in the material library: 
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The tensile strength refers to the highest stress reached under concentric tensile loading. 
 
The characteristic strengths for fck and the corresponding mechanical characteristics necessary for design, are 
given in Table 3.1: 
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 Design compressive and tensile strengths (art 3.1.6) 

 
The value of the design compressive strength is defined as 
 

fcd = cc fck / C          (3.15) 
 
where: 
 

C is the partial safety factor for concrete. 

cc is the coefficient taking account of long term effects on the compressive strength and of 
unfavourable effects resulting from the way the load is applied. 
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The value of αcc should lie between 0,8 and 1,0. The recommended value is 1,0. 
Remark: the Belgian National Annex recommends the use of the value 0,85. 
 
 
 
The value of the design tensile strength, fctd, is defined as 
 

fctd = ct fctk,0,05 / C         (3.16) 

 

where: 
 

C is the partial safety factor for concrete. 

ct is a coefficient taking account of long term effects on the tensile strength and of unfavourable 
effects, resulting from the way the load is applied. 

 
The recommended value of αct is 1,0. 
 
 
The values of the coefficients taking account of long term effects can be found in the Concrete setup of the 
National Annex: 
 

 
 
 

If the concrete strength is determined at an age t > 28 days the values cc and ct should be reduced by a 
factor kt. 
 
The recommended value of kt is 0,85. 
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 Elastic deformation (art 3.1.3) 

 
The elastic deformations of concrete largely depend on its composition (especially the aggregates). The values 
given in this Standard should be regarded as indicative for general applications. However, they should be 
specifically assessed if the structure is likely to be sensitive to deviations from these general values. 
 
The modulus of elasticity of a concrete is controlled by the moduli of elasticity of its components. Approximate 

values for the modulus of elasticity Ecm, secant value between  c = 0 and 0,4fcm, for concretes with quartzite 
aggregates, are given in Table 3.1. 
 
For limestone and sandstone aggregates the value should be reduced by 10% and 30% respectively. For 
basalt aggregates the value should be increased by 20%. 
 

 
 
 
Variation of the modulus of elasticity with time can be estimated by:  
 

Ecm(t) = (fcm(t) / fcm)0,3 Ecm       (3.5) 
 

where Ecm(t) and fcm(t) are the values at an age of t days and Ecm and fcm are the values determined at 
an age of 28 days. The relation between fcm(t) and fcm follows from Expression (3.1). 

 
Poisson’s ratio may be taken equal to 0,2 for uncracked concrete and 0 for cracked concrete. 
 
 
 

 Creep and shrinkage (art 3.1.4) 

 
Creep and shrinkage of the concrete depend on the ambient humidity, the dimensions of the element and the 
composition of the concrete. Creep is also influenced by the maturity of the concrete when the load is first 
applied and depends on the duration and magnitude of the loading. 
 
The value of the creep coefficient can be set in the concrete settings by using the “Code-based settings” view 
or in the 1D member data if it is defined. If the type input of the creep coefficient is “Auto”, the creep coefficient 
can be calculated automatically by inputting the age of concrete and the relative humidity (see annex B.1. in 
EN 1992-1-1). 
 
If the type input of the creep coefficient is “User value”, the creep coefficient can be inputted directly by the 
user. 
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Where great accuracy is not required, a value found from a figure (Figure 3.1) may be considered as the creep 
coefficient, provided that the concrete is not subjected to a compressive stress greater than 0,45 fck (t0) at an 
age t0, the age of concrete at the time of loading. 
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 Stress-strain relations for the design of cross-sections (art 3.1.7) 

 
For the design of cross-sections, the following stress-strain relationship may be used: 
 

  
 
 

c2  is the strain at reaching the maximum strength in the parabola-rectangle diagram  

cu2  is the ultimate strain in the parabola-rectangle diagram 
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c3  is the strain at reaching the maximum strength in the bi-linear diagram  

cu3  is the ultimate strain in the bi-linear diagram 
 

 
The user can choose in the material library which one of the diagrams should be used for the calculation: 
 

 
 
 

  
 
 
 

 Reinforcing Steel 

 
 
The following clauses give principles and rules for reinforcement which is in the form of bars, de-coiled rods, 
welded fabric and lattice girders. They do not apply to specially coated bars. 
 

 Properties (art 3.2.2) 

 
The behaviour of reinforcing steel is specified by the following properties: 
 

- yield strength (fyk or f0,2k) 
- maximum actual yield strength (fy,max) 
- tensile strength (ft) 

- ductility (uk and ft/fyk) 
- bendability 
- bond characteristics (fR) 
- section sizes and tolerances 
- fatigue strength 
- weldability 
- shear and weld strength for welded fabric and lattice girders 
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The steel properties can be found in the material library: 
 

 
 
 
The mean value of density may be assumed to be 7850 kg/m3. 
The design value of the modulus of elasticity Es may be assumed to be 200GPa. 
 
This Eurocode applies to ribbed and weldable reinforcement, including fabric. 
 
The application rules for design and detailing in this Eurocode are valid for a specified yield strength range, fyk 
= 400 to 600 MPa. 
 
Table C.1 gives the properties of reinforcement suitable for use with this Eurocode: 
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 Design assumptions (art 3.2.7) 

 
For normal design, either of the following assumptions may be made: 
 

B1) an inclined top branch with a strain limit of ud and a maximum stress of kfyk / s at uk, 
where k = (ft/fy)k. 

B2) a horizontal top branch without the need to check the strain limit. 
 

The recommended value of εud is 0,9 εuk. The value of (ft/fy)k is given in Table C.1. 
 
 

 
 
 
In the material library the user can choose between the two assumptions: 
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 Durability and cover to reinforcement 

 

 

 Environmental conditions (art 4.2) 

 
Exposure conditions are chemical and physical conditions to which the structure is exposed in addition to the 
mechanical actions. 
 
Environmental conditions are classified according to Table 4.1: 
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In the Concrete settings, in the “Design defaults” view, the user can choose the desired exposure class. All 
items with a blue background colour can be overwritten in the 1D member data. 
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 Methods of verification (art 4.4) 

 
Concrete Cover : art 4.4.1 
 
 
 

 General (art 4.4.1.1) 
 
The concrete cover is the distance between the surface of the reinforcement closest to the nearest concrete 
surface (including links and stirrups and surface reinforcement where relevant) and the nearest concrete 
surface. 
 
The nominal cover shall be specified on the drawings. It is defined as a minimum cover, cmin, plus an allowance 

in design for deviation, cdev :  
 

cnom = cmin + cdev 

 

 

 
 Minimum cover, cmin (art 4.4.1.2) 

 
Minimum concrete cover, cmin, shall be provided in order to ensure: 
 

- the safe transmission of bond forces 
- the protection of the steel against corrosion (durability) 
- an adequate fire resistance 
 

The greater value for cmin satisfying the requirements for both bond and environmental conditions shall be 
used: 
 

cmin = max {cmin,b; cmin,dur + cdur, - cdur,st - cdur,add; 10 mm}   (4.2) 
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where: 
 

cmin,b  minimum cover due to bond requirement 
cmin,dur minimum cover due to environmental conditions 

cdur,  additive safety element 

cdur,st reduction of minimum cover for use of stainless steel 

cdur,add reduction of minimum cover for use of additional protection 
 
The recommended value of Δcdur,γ, Δcdur,st and Δcdur,add , without further specification, is 0mm. 
 
 
 

- In order to transmit bond forces safely and to ensure adequate compaction of the concrete, the 
minimum cover should not be less than cmin,b given in table 4.2. 

 

 
 
 
 

- The minimum cover values for reinforcement and prestressing tendons in normal weight concrete 
taking account of the exposure classes and the structural classes is given by cmin,dur. 

 
The recommended Structural Class (design working life of 50 years) is S4 for the indicative concrete 
strengths (given in Annex E of EN 1992-1-1). The recommended minimum Structural Class is S1. 
 
The recommended modifications to the structural class is given in Table 4.3N: 

 
 

 
 
 

The design working life and the special quality control can be defined in the concrete settings or in 
the 1D member data: 
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The recommended values of cmin,dur are given in Table 4.4N (reinforcing steel): 
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- The concrete cover should be increased by the additive safety element cdur, 
 

Where stainless steel is used or where other special measures have been taken, the minimum cover 

may be reduced by cdur,st. For such situations the effects on all relevant material properties should 
be considered, including bond. 
 

For concrete with additional protection (e.g. coating) the minimum cover may be reduced by cdur,add. 
 
For concrete abrasion special attention should be given on the aggregate. Optionally concrete 
abrasion may be allowed for by increasing the concrete cover (sacrificial layer). In that case, the 
minimum cover cmin should be increased by k1 for Abrasion Class XM1, by k2 for XM2 and by k3 for 
XM3. 
 
Abrasion Class XM1 means a moderate abrasion like for members of industrial sites frequented by 
vehicles with air tyres. Abrasion Class XM2 means a heavy abrasion like for members of industrial 
sites frequented by fork lifts with air or solid rubber tyres. Abrasion Class XM3 means an extreme 
abrasion like for members industrial sites frequented by fork lifts with elastomer or steel tyres or 
track vehicles. 
 
The recommended values of k1, k2 and k3 are respectively: 5 mm, 10 mm and 15 mm. 
 

 
 

The abrasion class can be inputted in the concrete settings or the 1D member data: 
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The values of k1, k2 and k3 are available in the National Annex: 
 

 
 
 
 
 

 Allowance in design for deviation (art 4.4.1.3) 
 
To calculate the nominal cover, cnom, an addition to the minimum cover shall be made in design to allow for the 

deviation (cdev). The required minimum cover shall be increased by the absolute value of the accepted 
negative deviation. 
 
The recommended value of Δcdev is 10 mm. 
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In certain situations, the accepted deviation and hence allowance, cdev, may be reduced. 
 
The recommended values are: 
 

- where fabrication is subjected to a quality assurance system, in which the monitoring includes 
measurements of the concrete cover, the allowance in design for deviation Δcdev may be reduced: 

 
10 mm ≥ Δcdev ≥ 5 mm 

 
- where it can be assured that a very accurate measurement device is used for monitoring and non-

conforming members are rejected (e.g. precast elements), the allowance in design for deviation Δcdev 
may be reduced:  

 
10 mm ≥ Δcdev ≥ 0 mm 

 
 
The special geometric control can be checked in the concrete settings or the 1D member data: 
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The values of cdev can be found in the National Annex: 
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Chapitre 2:   Design and Check 

 
 
 

 Analysis models 

 

  

 Eurocode 

 

Structural models for overall analysis (art 5.3.1) 
 
 
The elements of a structure are classified, by consideration of their nature and function, as beams, columns, 
slabs, walls, plates, arches, shells etc. Rules are provided for the analysis of the commoner of these elements 
and of structures consisting of combinations of these elements. 
 
For buildings the following provisions are applicable: 
 

1) A beam is a member for which the span is not less than 3 times the overall section depth. Otherwise 
it should be considered as a deep beam. 

 
2) A slab is a member for which the minimum panel dimension is not less than 5 times the overall slab 

thickness. 
 

3) A slab subjected to dominantly uniformly distributed loads may be considered to be one way 
spanning if either: 

- it possesses two free (unsupported) and sensibly parallel edges. 
- it is the central part of a sensibly rectangular slab supported on four edges with a ratio of the 

longer to shorter span greater than 2. 
 

4) Ribbed or waffle slabs need not be treated as discrete elements for the purposes of analysis, 
provided that the flange or structural topping and transverse ribs have sufficient torsional stiffness. 
This may be assumed provided that: 

- the rib spacing does not exceed 1500 mm 
- the depth of the rib below the flange does not exceed 4 times its width. 
- the depth of the flange is at least 1/10 of the clear distance between ribs or 50 mm, whichever 

is the greater. 
- transverse ribs are provided at a clear spacing not exceeding 10 times the overall depth of 

the slab. 
 

The minimum flange thickness of 50 mm may be reduced to 40 mm where permanent blocks are incorporated 
between the ribs. 
 
A column is a member for which the section depth does not exceed 4 times its width and the height is at least 
3 times the section depth. Otherwise it should be considered as a wall. 
 

 

 Scia Engineer 

 
 

 ASSIGNMENT OF ANALYSIS MODEL 

 
In SCIA Engineer, several types of analysis models are available. It is up to the user to decide which model 
should be used for which element. 
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For 1D members, there is the choice between Beam, Beam slab and Column calculation. 
Each element has a property ‘Type’ assigned to it, to determine which type of calculation will be used: 
 

 
 
The Beam calculation is used for the Types ‘General’, ‘Beam, ‘Rafter’, ‘Purlin’, ‘Roof bracing’, ‘Wall bracing’, 
‘Girt’, ‘Truss chord’ and ‘Truss diagonal’. 
 
The Beam slab calculation is used only for the Type ‘Beam slab’. For this type, by default no shear 
reinforcement is added (unless necessary in case of a slab thickness of 200 mm or more, as defined in the 
Concrete Settings for slabs). As diameter for the longitudinal reinforcement, the default diameter for 2D 
structures – and not for beams! – is taken from the Concrete Settings. 
 
The Column calculation is used for the Types ‘Column’, ‘Gable column’ and ‘Secondary column’. 
 
Be careful when 1D member data are added to an element, via the Concrete workstation and “1D member 
data”. Also there, the user has the choice for the 3 different analysis models, by means of the option “Member 
type”: 
 

 
 
These 1D member data overwrite both the element properties and the default settings in the Concrete 
settings. 
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 DIFFERENCE BETWEEN BEAM AND COLUMN ANALYSIS MODEL 

 
The most important difference between Beam and Column calculation is the difference in reinforcement area 
per direction. A beam has an upper reinforcement area that differs from the lower reinforcement area. A column 
always has the same reinforcement configuration for the parallel sides, per direction. 
 

   
 
These configurations are obvious, and caused by the difference in dominant internal forces per calculation 
type. For a beam calculation the bending moment is dominant, while for a column calculation the axial 
compression force + bending moments (if present). 
 
So in fact, when the axial pressure on a beam is too high, the user should choose to calculate the element as 
a column. In the concrete settings an option is available to consider if the member is in compression or not. If 
the member is compressed, the second order effect is taken into account. Go to the Concrete workstation and 
“Concrete settings”, on the “Complete setup” view : 
 

 
 
 
This option ‘The coefficient for calculation force, where member as under compression’ will check how 
important the contribution of the axial compression force is: 
 

- If the axial compression load NEd < 0,1*Ac*fcd, the member is not considered to be in compression, 
which means the type ‘Beam’ is the right choice. 

 
- If the axial compression load NEd > 0,1*Ac*fcd, the member is considered to be in compression, which 

means the beam has to be modelled as type ‘Column’ and the second order effect will be taken into 
account. 

 Y 

 Z 

 Y 

 Z 
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 Example 

 

 
 
 

 
 
 
Under internal forces, a warning will be displayed in the detailed output whether it is necessary to calculate an 
element as column, to take into account the compression forces. If needed, the type has to be changed 
manually to column in the member properties or via 1D member data. 
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 Beam design 

 

 

 Description of used example 

 
The example that will be used to explain reinforcement calculation in a beam is called ‘beam.esa’. 
 
The beam reinforcement calculation is explained by means of the following two span beam:  
 

 
 
The length of the total beam is 10m and it has a dimension of 500x300mm.  
 
The inputted loads are: 
 

BG1 : self-weight 
 

BG2 : permanent load 
o Line load: -27kN/m 
o Point load: -100kN at position x = 0,25 

 
BG3 : variable load 

o Line load: -15kN/m 
o Point load: -150kN at position x = 0 

 
 
 

 Recalculated internal forces 

 
Reinforcement calculation in SCIA Engineer is based on recalculated internal forces. The pure internal forces 
calculated by the mechanical FEM calculation are transformed according to code regulation into ‘recalculated 
internal forces’ to design the reinforcement. 
 
These recalculated internal forces can be viewed in the Concrete settings of SCIA Engineer. 
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 Shifting of bending moments (art 9.2.1.3) 

 
Sufficient reinforcement should be provided at all sections to resist the envelope of the acting tensile force, 
including the effect of inclined cracks in webs and flanges. 
 
Additional tensile forces caused by shear and torsion are taken into account in SCIA Engineer by using the 
simplified calculation based on shifting of bending moments according to clause 9.2.1.3(2). Shifting of bending 
moments is calculated only for beams and beams as slab. 
 
For members with shear reinforcement the additional tensile force, ΔFtd, should be calculated. For members 
without shear reinforcement, ΔFtd may be estimated by shifting the moment curve a distance al = d (for beams 
as slab). This "shift rule" may also be used as an alternative for members with shear reinforcement, where: 
 

al = z (cot θ - cot α)/2  (for beams)      (9.2) 
 
 
The additional tensile force is illustrated in Figure 9.2: 
 

 
 
 
In SCIA Engineer, the user can review the recalculated internal forces. In the Concrete menu it is possible to 
view the internal forces and recalculated internal forces. In the figure below the difference is clearly visible: 
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The shifted moment line is taken into account for recalculated internal forces and by this also for the calculation 
of longitudinal reinforcement, if activated in the concrete settings (for the global structure) or in the 1D member 
data (individually per member): 
 
 

 
 
 

 
 

 REDUCTION OF BENDING MOMENT (art 5.3.5.5 (3) & 5.3.2.2 (4)) 
 
Another typical case of recalculated internal forces is the moment capping at supports.  
 
Where a beam or slab is monolithic with its supports, the critical design moment at the support should be taken 
as that at the face of the support. The design moment and reaction transferred to the supporting element (e.g. 
column, wall, etc.) should be generally taken as the greater of the elastic or redistributed values. 
 
Regardless of the method of analysis used, where a beam or slab is continuous over a support which may be 
considered to provide no restraint to rotation (e.g. over walls), the design support moment, calculated on the 

basis of a span equal to the center-to-center distance between supports, may be reduced by an amount MEd 

as follows: 
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MEd = FEd,sup t / 8         (5.9) 
 
where: 

FEd,sup is the design support reaction 
t  is the width of the support  

 
In SCIA Engineer this reduction of bending moment is only taken into account if it is activated in the concrete 
settings (for the global structure) or in the 1D member data (individually per member): 
 
 

 
 
 

 
 
 
The way in which the moment reduction is performed, is based on the type of support. If a standard support is 
defined, the reduction will be done following formula 5.9. If a column is defined the, reduction at the face of the 
column is used. 
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At the face of the column (5.3.2.2 (3))  Using formula 5.9 (5.3.2.2 (4)) 
 

 
 
 
In SCIA Engineer, the width “t” used for the moment reduction at supports can be set in the properties of that 
support: 
 

 
 
 
In the bottom of the 1D member data, there is an action button “Update support width”. This button collects all 
linked members or supports of the selected member and reads their support widths. 
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The reduction of moment by moment capping at supports is illustrated for our example below: 
 

- t = 0,2m 
- FEd,sup = 477,5kN 
- ΔMEd = 477,5*0,2 / 8 = 11,94kNm 

 
 
 
The original moment My at the support was 254,16kNm: 
 

 
 
 
 
The recalculated moment clearly shows the shifting of the moment line. 
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With moment capping at support taken into account the recalculated moment is 242,22kNm. 
 

 
 
 
 
 

 REDUCTION OF SHEAR FORCES (art 6.2.1 (8)) 

 
For members subject to predominantly uniformly distributed loading, the design shear force does not need to 
be checked at a distance less than d from the face of the support. Any shear reinforcement required should 
continue to the support. In addition it should be verified that the shear at the support does not exceed VRd,max. 
 
In SCIA Engineer, this reduction of shear forces is only taken into account if it is activated in the concrete 
settings (for the global structure) or in the 1D member data (individually per member): 
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It is possible to choose the type of reduction of shear forces at the face of the support or at a distance d from 
the face of the support: 
 
 

At the face of the column 
 
 

 
 
 
 
Also for the reduction of shear forces, the support width “t” is taken into account, which is taken from the 
properties of the support or the 1D member data. The reduction of shear forces at supports is illustrated for 
our example below with t = 0,2 m. 
 
 
The first image displays the original Vz : 
 

 
 
 
 

At the face of the column + effective 
depth of the cross section (based on 

6.2.1 (8)) 
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The second image shows the reduction at the face of the support: 
 

 
 
 
The last image shows the reduction at the effective depth from the face: 
 

 
 

 

 

 Theoretical reinforcement 

 
 
 

 CONFIGURATION 
 
 
The theoretical reinforcement is calculated out of the recalculated internal forces. It gives the amount of 
reinforcement needed to resist the internal forces induced by ULS loads. Since there are several workflows 
possible to design concrete beam elements, the theoretical reinforcement design is not mandatory to perform. 
Experienced users can directly jump to practical reinforcement to perform the checks on, but this theoretical 
approach gives a good idea of how this practical reinforcement should look like. There are two types of 
theoretical reinforcement: 
 
Required reinforcement:  The required reinforcement is a numerical value (mm²) of the reinforcement that is 
necessary in every section of the beam.  
 
Provided reinforcement: The provided reinforcement is a template added to each beam/column consisting 
of basic and additional reinforcement. 
 
The configuration of theoretical reinforcement can be found in the Concrete settings, in the “Design defaults” 
view. Templates of longitudinal reinforcement and stirrups for different shapes of beam are available. The 
concrete cover can be set for upper, lower and side faces.  
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Several default templates for longitudinal reinforcement and stirrups are available for the different section types 
(provided reinforcement). These can be adapted or new ones can be made. 
 

 
 
 
This template exists of basic, additional and shear reinforcement. The purpose is to compare these templates 
with the required reinforcement, to model the user reinforcement that is introduced later on or to convert it 
automatically to user reinforcement. 
 
 

 Longitudinal reinforcement 
 
The basic reinforcement is present along the whole length of the beam; the additional reinforcement is present 
only at the zones where basic reinforcement is not sufficient to withstand (recalculated) internal forces. 
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 A choice can be made between fixed additional bars (diameter and number) or a list with different numbers 
of bars with a fixed diameter. SCIA Engineer uses the least amount of necessary additional bars or places the 
maximum if this template is still not sufficient to resist the (recalculated) internal forces. Next to the basic and 
additional reinforcement you can also set a diameter for the detailing reinforcement. The detailing 
reinforcement is reinforcement that statically is not required but that needs to be added to the cross-section to 
fulfil the detailing provisions. 
 

 
 
 

 Shear reinforcement 
 
For the shear reinforcement the number of cuts, the maximum number of stirrup zones, the diameter and the 
spacing can be set. For the spacing different types of input can be used: Multiple and User defined. Multiple 
means that the spacing between the stirrups will be the multiple of a set value. With User defined reinforcement 
the user can set the spacings that can be used. SCIA Engineer will automatically select the spacing depending 
on this template and the general settings in the design defaults. The option Symmetrical allows the user to 
define whether the zones in each span will be symmetrical or not.  
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 CONFIGURATION FOR CONVERSION TO REBARS 
 
 
The configuration for conversion to rebars can be found in the Concrete settings, in the “Complete setup” view. 
Different options are available: 
 

 
 
 

 Unify upper reinforcement above middle support 
 
Unifies the number of bars of upper reinforcement at the middle support. The maximum number of bars from 
the left and right side of the support are taken into account. 
 

 
 
 

 Minimum length of longitudinal reinforcement 
 
Sets a minimum length for the longitudinal reinforcement. 
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 Uniformly distributed reinforcement for the column 
 
Uniform distribution of reinforcement along the whole length of the column, with maximum area from y and z 
edges in all sections taken into account. 
 

 
 
 

 Number of corrected bars (neighbouring sections) 
 
Additional reinforcement is tested in each section for number of bars and diameter in neighbouring sections. If 
the additional reinforcement can be distributed to the stirrup links between basic reinforcement bars, the 
number of bars and diameter of additional reinforcement is increased to fulfil conditions. The reason for the 
correction of the number of bars of additional provided reinforcement is to have logic and symmetrical 
reinforcement in the cross-section along the beam. 
 

 
 
 

 Type of zone for corrected shear reinforcement 
 
None - Zones for shear reinforcement are not created. Conversion of provided reinforcement to real bars is 
not possible. 

(A) Geometrical – Member is in every span divided geometrically in zones with the same length. 
(B) Spacing – Member is in every span divided in zones according to the most occurrent spacing. 
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 CALCULATION OF LONGITUDINAL REINFORCEMENT As 

 
The longitudinal reinforcement calculation is based on My,recalc represented in the previous chapter. 
 
The only thing left to be set in the concrete setup is the material quality and default diameter: 

- Material quality is set to B 500A. This can be changed in the project data or concrete 1D member 
data. 

- The default diameter is set to 16mm. This parameter is taken from the additional reinforcement 
diameter of the reinforcement template under Design defaults, or from 1D member data. 

 
The following results are obtained with these settings: 
 

 
 
 
In the following image you can see the brief output in the preview: 
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You can also ask a standard or a more detailed output where you can find more information about certain 
parameters used in the calculation, for example: 
 
d : lever arm of reinforcement. 

 
d = h – cover – Φstirrup – Φlongitudinal beam /2 = 500 – 35 - 8 – 16/2 = 449 mm 
 
(the cover is defined by the environmental class and is 35 mm for XC3) 
 

 
The only internal force working on this beam is Myd. Nd and Td are zero. 
 
Asy_req = 0 because there is no torsion on this beam. 
 
Note that the detailing provisions are deactivated. Otherwise no reinforcement of ϕ = 16mm could be proposed, 
since the detailing provisions are not met (bar distance too small). 
 
 
If the default diameter is set to 20mm, the following results are obtained: 

 

 
 
 

 
 
 

If you take a close look at these results, you can see that also the value for As,req has changed. 
 

This is because the lever arm d has decreased: 
 

d = h –cover –Φstirrup – Φlongitudinal beam /2 = 500 – 35 - 8 – 20/2 = 447 mm 
 

As you can see, the default diameter has also a slight effect on the amount of reinforcement that is required, 
because of the changed lever arm. 
 
 
Note : 1D member data can be used to change the default diameter for the bar to which these data are 
assigned. It is obvious that the 1D member data have higher priority than the Concrete settings. 
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Next to the required reinforcement area, also the unity check UC can be viewed to check for maximum 
reinforcement area and As,req (ϕ) for the reinforcement translated into bars. 
 

   
 
 
The provided reinforcement As,prov gives the amount of reinforcement or in bars (As,prov), determined by the 
template. As,add, req = As,req - As,prov , thus the  amount of reinforcement which still has to be added to the template 
to resist the (recalculated) internal forces. If As,prov > As,req , As,add,req = 0. 
 
Also unity checks can be performed on the provided reinforcement. 
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 CALCULATION OF SHEAR REINFORCEMENT Aswm 

 
 

 
 
 

VEd  = design shear force resulting from external loading 
VRd,c = design shear resistance of the member without shear reinforcement  
VRd,s  = design value of the shear force which can be sustained by the yielding shear reinforcement  
VRd,max  = design value of the maximum shear force which can be sustained by the member, limited 

by crushing of the compression struts 
 
 
In general we can have three cases: 

 
- VEd > VRd,max    Concrete strut failure 
 
- VEd ≤ VRd,c    Shear force carried by concrete. No shear reinforcement necessary 
              (minimum shear reinforcement according to detailing provisions) 
 
- VEd > VRd,c and VEd < VRd,max Shear reinforcement necessary in order that: VEd ≤ VRd 

 
 
 

 Members NOT requiring design shear reinforcement: VEd < VRd,c (art 6.2.2) 
 
 

  VRd,c = [CRd,c k(100 ρl fck)1/3 + k1 σcp] bw d      (6.2.a) 
 
with a minimum of : 

  VRd,c = (vmin + k1 σcp) bw d       (6.2.b) 
 
where: 

fck      = characteristic concrete compressive strength [MPa] 
k        = size factor: k = 1 + √(200/d) ≤ 2,0 (with d in mm) 
ρl = longitudinal reinforcement ratio: ρl = Asl/bwd ≤ 0,02 
bw    = smallest web width of the cross-section in the tensile area [mm] 
σcp = concrete compressive stress due to loading: σcp = NEd/Ac < 0,2 fcd [MPa] 
d         = effective height of cross section 

 
 

The recommended value for CRd,c is 0,18/γc, that for k1 is 0,15 and that for vmin is given by expression: 
vmin = 0,035 k3/2. fck

1/2        (6.3N) 
 

 
The shear force VEd, calculated without reduction by β, should always satisfy the condition: 

  VEd ≤ 0,5 bw d v fcd        (6.5) 
 

where v is a strength reduction factor for concrete cracked in shear. 
 
The recommended value for v follows from: 

  v = 0,6 [1-
fck

250
]         (6.6N) 
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In SCIA Engineer, it is possible to input the following parameters:  
 

 
 
 
Note : the green values are according to EN code. 
 
 

 Members requiring design shear reinforcement VEd > VRd,c (art 6.2.3) 
 
The design of members with shear reinforcement is based on the theory of the concrete truss-model. In this 
theory, a virtual truss-model is imagined in a concrete beam. This truss-model has a set of vertical (or slightly 
diagonal), horizontal and diagonal members. The vertical bars are considered to be the stirrups, the horizontal 
bars are the longitudinal reinforcement bars and the diagonal bars are the concrete struts. 

 

 
 
 
The angle θ should be limited. 
 
The recommended limits of cot θ are given: 
  1 ≤ cot θ ≤ 2,5         (6.7N) 

 
The angle θ can be inserted in SCIA Engineer: 
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For members with vertical shear reinforcement, the shear resistance VRd is the smaller value of: 

 

  VRd,s = 
Asw

s
 z fywd cot θ        (6.8) 

 
  and 
 
  VRd,max = αcw bw z v1 fcd/(cot θ + tan θ)      (6.9) 

 
where: 

 Asw = cross-sectional area of the shear reinforcement 
 s = spacing of the stirrups 
 fywd = design yield strength of the shear reinforcement 
 v1 = strength reduction factor for concrete cracked in shear 
 αcw = coefficient taking account of the state of the stress in the compression chord 

 
 
 
The recommended value of v1 is v (see Expression 6.6N) 
 
If the design stress of the shear reinforcement is below 80% of the characteristic yield stress fyk, v1 may be 
taken as: 
 
 v1 = 0,6    for fck ≤ 60 MPa      (6.10.aN) 
 v1 = 0,9 – fck/200 > 0,5  for fck ≥ 60 MPa      (6.10.bN) 
 
The recommended value of αcw is 1 for non-prestressed structures. 

 
 

 
 
These code related parameters can be found in the Concrete setup: 
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If we go back to our example in SCIA Engineer, we find the following Aswm,req for the whole beam: 

 

 
 

 
 
 
The maximum value of 1315 mm2 corresponds to a two section stirrup of ϕ = 8mm every 75 mm. 
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 Practical reinforcement 

 
We will now pass on to the level of practical reinforcement. This will allow us to specify the reinforcement 
locally over the beam. 
 
In the theoretical reinforcement design, we have calculated where reinforcement is needed. 
This allows us to input manually the practical reinforcement by adding New reinforcement for the whole length 
of the beam. 
 
We can first select a template for the longitudinal reinforcement: 
 

 
 
 
Next, we have to decide where the parameters of reinforcement are coming from: 
 

 
 
 
The practical reinforcement is shown graphically on the screen: 
 

 
 
 
As a user, you can add locally New stirrups or New longitudinal bars. 
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For the stirrups, you can select a certain stirrup shape: 
 

 
 
 
The stirrup shape can be edited or a new one can be made. Therefore user points may be added. 
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For the longitudinal reinforcement, we can define precisely where the extra practical reinforcement needs to 
be putted: 
 

    
 
 
 
The selected zone of the member can be modified by the properties panel or by the menu Library / Concrete, 
Reinforcement / Longitudinal Reinforcement Library : 
 

 
 
 
 
Here can be set on which face extra reinforcement needs to be added: 
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For reasons of simplicity we will add 3 bars of 20mm that are still needed over the whole area where extra 
reinforcement is required. This can of course be done more detailed. 
 
The same procedure will be repeated for the upper reinforcement over the support. 
 
Also the shear reinforcement needs to be increased in the zones over the support. This can be done by 
increasing the diameter of the stirrups or by decreasing the distance between the stirrups. 
 
Different stirrup zones can be created: 
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To check if there is enough shear reinforcement, a capacity check needs to be performed. This will be 
explained in the next chapter. 
 
By selecting the reinforcement it is always possible to change the parameters afterwards through the property 
window. 
 
Through view parameter settings a 3D representation of the reinforcement can be obtained: 
 

 
 
 
The total practical reinforcement of the beam is shown below: 
 

 
 
 
A zoomed view shows the 3D representation: 
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 Conversion of theoretical reinforcement into practical reinforcement 

 
Since SCIA Engineer 19 it is also possible to convert theoretical reinforcement into practical reinforcement. As 
mentioned in previous chapter there are two types of theoretical reinforcmeent: Required reinfocement (= 
mm² necessary in each section) and Provided reinforcement (= template of reinforcement with various 
ammounts of additional reinforcement possible). It is only possible to convert Provided reinforcement into 
practical (=user) reinforcement. 
 
 
Let’s have a look at this example : open beam.esa 
 
Set the template of provided reinforcement. 
 

 
 
 
Go to Reinforcement design and look at the value As,prov(ϕ). This is the provided reinforcement that will be 
converted into practical reinforcement. 
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Press ‘Conversion for real bars’  
 

 
 
 
The following reinforcement is generated. 
 

 
 
 
The practical reinforcement is added as reinforcement data. You can edit the reinforcement by selecting it and 
then click on ‘Edit reinforcement’. 
 

 
 
 
Now the parts of the reinforcement that needs edditing can be slected. The diameter, number of bars, length, 
spacing , … can be changed in the properties window. 
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Remark: 
 
It might occur the error message ‘Conversion of reinforcement was not done because the Type of zone 
of shear reinforcement is set to ‘None’ in the Design defaults’ appears within the summary after 
conversion when converting the provided reinforcement into real bars. This behaviour is caused due to the 
option ‘None’ is selected for the setting ‘Type of zone for corrected shear reinforcement’ within the design 
defaults.  
 

 
 
 
In the example, we will increase the length and diameter of reinforcement area 5. 
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 Checks 

 
In SCIA Engineer, checks can be performed in three different ways: 

1. With practical reinforcement inputted on the member, checks can be done one by one for all sections 
of the member 

2. With practical reinforcement inputted on the member, overall ULS or SLS checks can be done for a 
specific section of the member with the tool “Section check” 

3. Without practical reinforcement, overall ULS or SLS checks can be done for a specific section of the 
member with the tool “Section Check”. Reinforcement will then be added locally in the Section check 
tool to be able to perform the various available checks.  

 
 
First you get an overview of the input data for the checks: 

- Internal forces: displaying the characteristic and design values 
- Slenderness: determining if 2nd order effects need be considered (for member type 'column') 
- Stiffnesses: displaying the values EA, EIy and EIz 

 
Available checks at the Ultimate Limit State are: 

- Capacity check: for N-My-Mz interaction - based on resistance calculated from interaction 
diagram 

- Response check: based on check of ultimate stresses and strains for N-My-Mz interaction 
- Check of shear and torsion 
- Check of interaction of shear, torsion, bending and normal force 

 
Available checks at the Serviceability Limit State are: 

- Stress limitation (for concrete as well as reinforcing steel) 
- Crack width limitation 
- Simple check for deflection: based on calculation of stiffness ratio, without necessity to 

calculate Code Dependent Deflection (CDD) 
 
 
The capacity, response and shear + torsion check should be okay if no additional reinforcement is required. 
 
However, these checks give interesting information on the efficiency of reinforcement. For instance, if in a 
section only 50% of reinforcement is used, then we can conclude that here less reinforcement would have 
been sufficient. 
 
The detailing provisions and the crack limitation are extra checks that are not accounted in the reinforcement 
design. If these checks are not okay, then the practical reinforcement needs to be changed. 
 
 



Advanced Concept Training – Concrete 

62  MJA / TC – 2023/01/16 

In the following chapters, we will explain the checks one by one when practical reinforcement is inputted. It 
corresponds to the 1st method to perform a check (see above). 
 
Example 1: ‘beam_practical reinforcement.esa’ 
 
The last chapter will be focused on the Section check tool, corresponding to 2nd and 3rd methods to perform a 
check (see above). 
 
Example 2: ‘beam_without practical reinforcement.esa’ 
 
 
 

 CAPACITY RESPONSE 
 
 
The Capacity - response is based on the calculation of strain and stress in a particular component (concrete 
fibre or reinforcement bar). 
The check consists of the comparison of those strains and stresses with the limited values according to EN 
1992-1-1 requirements. 
 
However, this method does not calculate extremes (capacities of the cross-section) like the interaction 
diagram, but calculates the state of equilibrium for that section (response). 
For capacities of the member, please refer to the “Capacity – diagram” check.  
 
The following checks are performed: 

• Check of compressive concrete (cc) 

• Check of compressive reinforcement (sc) 

• Check of tensile reinforcement (st) 
 
The Unity Check, UC, displayed on the screen will be the maximum value of those 3 checks. 
 
 
Example: ‘beam_practical reinforcement.esa’ 
 
Run the Capacity – Response check in Design > Concrete 1D > ULS response check. 
 
The maximum value of the check is given on the middle support. The Standard output gives: 
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In the Standard output you can read the UC, and the extreme strain and stress in the studied section. 
 
 
In the Detailed output you will get all the strains and stresses and the limit strains and stresses: 
 

 
 
 
Note that the tensile stress in concrete is not considered, therefore the corresponding UC is 0. 
 
 
Stress and strain diagrams are also available in the Detailed output: 
 

 
 
 
Settings that might influence the check: 
 

• Effective depth of cross-section - d  
 
It is usually defined as distance of the most compressive fibre of concrete to center of gravity of tensile 
reinforcement. In SCIA Engineer, the effective depth of cross-section is defined as distance of the most 
compressive fibre of concrete to position resultant of forces in tensile reinforcement. 
 

 
 
The effective depth d cannot be calculated in the following cases: 

- The most compressive fibre cannot be determined (the whole cross-section is in tension) 
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- Resultant of forces in tensile reinforcement cannot be determined (whole section is in 
compression) 

- Equilibrium is not found 
- Distance of the most compressive fibre and Resultant of forces in tensile reinforcement is less 

than 0,5*h 
 
In those cases, the effective depth is calculated according to formula : 

d = Coeffd * hl 
 
With : 

Coeffd by default 0,9 in Concrete settings, in “Complete Setup” view, and in “Solver settings” 
/ “General” 

hl  height of cross-section perpendicular to neutral axis 
 

 
 
 

• Inner lever arm 
 
z is defined in EN 1992-1-1, clause 6.2.3 (3) as the distance between position resultant of tensile force (tensile 
reinforcement) and position of resultant of compressive force (compressive reinforcement and compressive 
concrete). 
The inner lever arm cannot be calculated in the following cases: 

- The most compressive fibre cannot be determined (the whole cross-section is in tension) 
- Resultant of forces in tensile reinforcement cannot be determined (whole section is in 

compression) 
- Equilibrium is not found 

 
In those cases, it is calculated according to formula : 

z = Coeffz * d 
 
With: 

Coeffz by default 0,9 in Concrete settings, in “Complete Setup” view, and in “Solver settings” 
/ “General” 
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For additional information about this check and the theoretical background, please refer to our web help. 
 
 

 CAPACITY DIAGRAM 
 
 
Capacity - diagram services uses the creation of interaction diagram (graph presenting the capacity of a 
concrete member to resist a set of N + My + Mz).  
 
This check calculates the extreme allowable interaction between the normal force N and bending moments My 
and Mz.  
 
 
Example: ‘beam_practical reinforcement.esa’ 
 
Run the Capacity – Diagram check in Design menu > Concrete 1D > ULS capacity diagram check 
 
The standard output gives the summary result of the check: 
 

 
 
 
The Detailed output gives additional info about how the check is performed: 
 

 
 
 
Interaction diagrams are also drawn in the Detailed output: 
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. 
 
 
Settings that might influence the check: 

• Interaction diagram method 

• Division of strain 

• Number of points in vertical cuts 
 
For additional information about this check and the theoretical background, please refer to our web help. 
 
 
 

 SHEAR + TORSION 
 
 
Check of Interaction shear and torsion consists of three checks according to clause 6.1 - 6.3 in EN 1992-1-1: 

• check of shear 

• check of torsion 

• check of interaction of shear and torsion 
 
This check can be performed if the following conditions are met: 

• The material of all reinforcement bars and stirrups are the same 

• The angle between gradient of the strain plane and the resultant of shear forces is not greater 
than 15°  

• Cross-section with one polygon and one material 
 
 
Example: ‘beam_practical reinforcement.esa’ 
 
Run the Shear + Torsion check in Design > Concrete 1D > ULS Shear and Torsion check 
 
Some parts of the beam do not satisfy: 
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The Standard output allows us to identify which specific check is not satisfied: 
 

 
 
Here the shear forces cause a unity check >1. 
 
In the Detailed output we can read notes, warning and errors about the design. For example, for the shear 
forces check not satisfied, the report clearly explains that the shear reinforcement is not sufficient and that we 
have to increase it.  
 

 
 
 
Various actions can be done to fix this issue. In this example, we choose to decrease the spacing of the stirrups 
in the section where there is an issue. 
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Select stirrups and click on “Edit stirrups distances” at the bottom of the Properties of the stirrup layers: 
 

 
 
 
Select “Zone 2” and change the distance between stirrups from 0.3 m to 0.1 m. Apply the same procedure for 
“Zone 4” and modify the spacing to 0,2 m: 
 

 
 
 
We could also have added more stirrups like below: 
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Changing the stirrup shape allows us to keep a bigger distance of 0.2m between stirrups in “Zone 2”. 
 
After modification, the shear + torsion check is satisfied: 
 

 
 
 
 
Settings that might influence the check: 
 

• Coefficient for calculation of effective depth of cross-section 
 
Default value 0,9 in Concrete settings > Complete Setup view > Solver settings > General 
 

• Coefficient for calculation of inner lever arm 
 
Default value 0,9 in Concrete settings > Complete Setup view > Solver settings > General 
 

• Angle of concrete compression strut 
 
3 types of input in Concrete settings > Solver settings > Shear: 

- User (angle)  user input of the angle – by default 
- User (cotangent)  user input of the cotangent 
- Auto    automatic calculation of the angle fulfilling equation 6.29  
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The angle should be between θmin and θmax defined in the NA for EN1992-1-1. 
 

 
 
 

• Angle of shear reinforcement 
 
Practical reinforcement can only be introduced at 90°. 
 

• Type for determination equivalent thin-walled cross-section 
 
 
For additional information about this check and the theoretical background, please refer to our web help. 
 
 
 

 STRESS LIMITATION 
 
 
Stress limitation is based on the verification of: 
 

• compressive stress in concrete - the high value of compressive stress in concrete could lead to 
appearance of longitudinal cracks, spreading of micro-cracks in concrete and higher values of 
creep (mainly nonlinear). This effect can lead to a state where the structure is unusable. 
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• tensile stress in reinforcement - stress in reinforcement is verified due to limitation of 
unacceptable strain existence and thus appearance of cracks in concrete. 

 
 
Example: ‘beam_practical reinforcement.esa’ 
 
The stress limitation check is done according to the following steps: 

- Verification of crack appearance 
- Verification of the stresses 

 
 
The Standard output shows those 2 steps: 
 

 
 
 
Verification of crack appearance 
 
Crack appearance is verified for characteristic load combination in accordance to chapter 7.1(2) in EN1992-1-
1: 

• σct ≤ fct,eff  no crack appears 

• σct > fct,eff  crack appears 
 
With: 

σct  maximal tensile stress in concrete fibre 
fct,eff  effective concrete tensile strength  

  
 
Verification of stresses 
 
There are 3 stress limitations checked: 

• σc,char,lim ≤ k1 * fck  concrete stress under Char. load – 7.2(2) - exposure classes XD, XF, XS 

• σc,qp,lim ≤ k2 * fck concrete stress under Quasi Perm. load – chapter 7.2(3) 

• σs,char,lim ≤ k3 * fyk reinforcement stress under Char. Load – chapter 7.2(5) 
 
Values of k1, k2, k3, are defined in the NA, standard values are respectively 0.6, 0.45, 0.8 
 
Additionally, when the stress in the reinforcement is caused by an imposed deformation, then the maximal 
strength is increased to k4 * fyk, where k4 is NA parameter with standard value k4 = 1,0. 
This option can be activated in Concrete settings > Stress limitations:  
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By default, stress limitation check is done for short-term state.  
It is possible to perform a long-term state. Effective E modulus of elasticity is calculated as follows, using the 
creep coefficient:  
 

Ec,eff = Ecm / (1+ φ) 
 
Long-term behaviour can be activated in Concrete Setting > Complete Setup view > Solver settings > General 
> SLS > Use effective modulus of elasticity. 
The creep coefficient can whether be calculated by the software or inputted manually in the Concrete settings. 
 

 
 
 
Note: Scia Engineer is not able to use characteristic or quasi-permanent combinations together in one step. 
Therefore, the same forces (load combination) are used for crack appearance and final stress values. 
 
 



Chapitre 2:  Design and Check 

MJA / TC – 2023/01/16  73 

 CRACK WIDTH 
 
The crack width is calculated according to clause 7.3.4 in EN 1992-1-1. 
 
The following preconditions are used for calculation: 

• The crack width is calculated for beams and columns and for general loads (N + My + Mz) 

• Cross-section with one polygon and one material is considered in version SEN 17 

• The material of all reinforcement bars must be the same in SEN 17 

• Appearance of cracks should be calculated for a characteristic combination according to EN 
1992-1-1, clause 7.2(2). A simplification is made in SEN 17 that the normal stress is calculated 
for the same type of combination as used for the calculation of crack width, inputted in service 
Crack control. 

 
 
Example: ‘beam_practical reinforcement.esa’ 
 
First a determination whether the section is cracked or un-cracked is performed by comparing: 

• σct ≤ σcr  Uncracked 

• σct > σcr Cracked 
 
Value for σcr can be set in the Concrete settings > Cracking forces. Two options can influence this value: 
 

 
 
 
Value of strength for calculation of cracking forces:  

• σcr = 0MPa  cracks appear when tensile stress occurs in the section 

• σcr = fct,eff cracks appear when tensile effective strength of concrete is reached in the section 
 
 
Type of strength for calculation of cracking forces:  
If previous option is set on σcr = fct,eff, which is the default value then:  

• fct,eff  = fctm mean tensile strength of concrete at 28 days set in the material properties. 

• fct,eff  = fctm,fl mean flexural tensile strength (EN 1992-1-1,clause 3.1.8(1)). This value should be  
used if restrained deformations such as shrinkage or temperature movements are  
considering for calculation crack width. 
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Note: The value presented in material properties (picture above) is the mean tensile strength at 28 days. If 
cracking is expected earlier than 28 days, it is necessary to input this value fctm(t) into the material properties 
(EN 1992-1-1,clause 3.1.2(9)). 
 
 
The check of crack appearance, with values of cracking forces (Ncr, Mcry, Mcrz) can be read in the Detailed 
output: 
 

 

 



Chapitre 2:  Design and Check 

MJA / TC – 2023/01/16  75 

 
Here, modulus E is taken for short-term state. As mentioned previously, long-term state with an effective 
modulus Eeff can be chosen in Concrete settings > Complete Setup view > General > SLS > Use effective 
modulus E. 
 
In this example, cracks appear.  
Crack width is then calculated according to EN 1992-1-1, formula 7.8: 

w = sr,max • (εsm - εcm) 
 
For further details about the calculation, the Detailed output can be analysed. The following picture shows only 
a part of the report: 
 

 

 
 
 
Standard output will give the summary values: 
 

 
 
 
The limit value of the crack width wmax is by default automatically calculated according to EN 1992-1-1 (Table 
7.1N). The allowable crack width can be seen in the NA setup: 
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Chapitre 2:  Design and Check 

MJA / TC – 2023/01/16  77 

 
The user can manually input the limiting crack width in the Steel workstation > 1D member data:  
 
 

 
 
 
 

 DEFLECTION 
 
 
The calculation of deflection is done according to chapter 7.4.3 from EN 1992-1-1. 
 
Two kinds of deflection calculations are possible in the software: 

• Simplified method where the calculation is done twice, assuming the whole member to be uncracked 
and fully cracked, and then interpolating formula 7.18 according to clause 7.4.3(7). This is the default 
used method. 

• Code dependent deflection. This is the most rigorous method to calculate deflection by computing the 
calculation of curvatures at frequent sections along the member and then calculate the deflection by 
numerical integration. More information about this method can be found in the chapter Code 
dependent deflections. 

 
 
 
The calculation procedure for the simplified method can be described in the following steps: 
 

1. Calculation of short-term stiffness using E modulus at 28 days. 
 

2. Calculation of long-term stiffness using effective E modulus based on creep coefficient. 
 

In the current version of the software, it is not possible to distinguish between the short-term and long-
term part of the load in a combination. Therefore, some preconditions have been established for 
determination of the long-term part of the load. The long-term part of the load (LongTermPercentage) 
is estimated based on the type of combination. There are three main SLS combinations: 
 
SLS characteristics - LongTermPercentage = 70 % 
SLS frequent - LongTermPercentage = 85 % 
SLS quasi-permanent- LongTermPercentage = 100 % 
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The creep-factor is calculated by the software depending on the relative humidity, outline of the cross-
section, reinforcement percentage, concrete class, etc. It can also be manually inputted in the 
Concrete setup > Complete setup view > General > Creep: 
 

 
 
 

3. Calculation of stiffness ratios between each state, short and long term. 
It is the ratio of linear stiffness of the concrete component divided by the resultant stiffness taking 
cracks into account. The calculation of resultant stiffness is based on clause 7.4.3 (3), formula 7.18.  
 

bending stiffness around y-axis (EIy) = 1/[/(EIy)II + (1-)/ (EIy)I] 

bending stiffness around z-axis (EIz) = 1/[/(EIz)II + (1-)/ (EIz)I] 

axial stiffness (EA) = 1/[(/(EA)II + (1-)/( EA)I] 
In this formula (EI)I is the linear stiffness, (EI)II is the stiffness of the cracked element (= long term 

stiffness = Elin / 1 + φ) and   is the distribution coefficient. 
 

  
 
ratio = Stiffnesslin / Stiffnessres, for example ratiouz = EIz,lin / EIz,res 

 
 

4. Calculation of deflection components 
Several components are needed to calculate the total and additional deflection. 
 
In the following part we will note “s” for short term and “l” for long term. 
 
The components are: 
δlin linear (elastic) deflection, δlin = δlin,s + δlin,l 

δimm immediate deflection, δimm = δlin,l ∙ ratios 

δs short-term deflection, δs = δlin,s ∙ ratios 
δl,creep long-term deflection + creep, δl,creep = δlin,l ∙ ratiol 
δcreep creep deflection, δcreep = δlin,l ∙ (ratiol - ratios) 
δl long-term deflection, δl = δl,creep - δcreep 
δadd additional deflection, δadd = δs + δl,creep - δimm 

δtot total deflection, δtot = δs + δl,creep 
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5. Check of deflections  

Two deflections are checked:  
Total deflection: The appearance and general utility of the structure could be impaired when the 
calculated sag of a beam, slab or cantilever subjected to quasi-permanent loads exceeds span/250.  
δtot,lim = L / 250 

 
Additional deflection: Deflections that could damage adjacent parts of the structure should be limited. 
 
δadd,lim = L / 500 
 
L is the buckling length multiplied by a β factor of the member in the corresponding direction. 
 
Final unity check is: 

Unity check =  max {
δtot

δtot, lim
; 

δadd

δadd, lim
  } 

 
 
The limits of deflection can be changed in Concrete settings > Complete setup view > Deflections: 
 

 
 
 
Example: ‘beam_practical reinforcement.esa’ 
 
Look at deflection check for the “SLS qp” combination. 
Various results can be displayed on the screen: UC, total and additional deflection or limits for total and 
additional deflection.  
 
Open the Standard output for the UC. At position dx = 2,5m we have the following result: 
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All ratio of stiffnesses and deflection components are resumed in a table. 
 
Open the Detailed output, for the same position dx = 2,5m. 
All previously mentioned steps for the calculation of the deflections can be found here.  
 
For example for the long-term stiffness, we can obtain the long-term part of the loads and the calculated creep 
coefficient: 
 

 
 
 
Uncracked (state I) and cracked (state II) cross section properties are also shown in a table:  
 

 
 

 
 
 
Which allows to calculate the stiffness’s ratio, for example the bending stiffness’s ratio: 
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And final the short and long-term ratios: 
 

   
 
 
Then all deflection components are calculated together with the limit deflections: 
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Limitations of the deflection check: 

• Deformation caused by shrinkage is not automatically considered. 

• Verification based on limiting span / depth ratio according to 7.4.2 is not implemented. 

• Calculation of deflection depends on the internal forces used for the reduced stiffness. 
Therefore, the check of deflection doesn’t work for cases where the internal forces are equal to 
zero but deflections are not zero. Typically, this is the case for a cantilever structure with free 
overhang. 

 
 
 

 DETAILLING PROVISIONS 
 
 
Scia Engineer distinguishes three types of member with their detailing provisions: 

• Beam - verification of longitudinal and shear reinforcement 

• Column - verification of main and transverse reinforcement 

• Beam slab - verification of longitudinal reinforcement only 
 
All detailing provisions are taken into account automatically in Concrete settings > Complete setup view > 
Detailing provisions: 
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Following table shows which checks of detailing provisions are performed: 
 

Member 
type 

Longitudinal (main) Shear (transverse) 

Beam 

8.2(2) - Minimal clear spacing of bars 
9.2.1.1(1) - Minimal area of longitudinal 
reinforcement 
9.2.1.1(3) - Maximal area of longitudinal 
reinforcement 
9.2.3(4) - Maximal center-to-center bar 
distance based on torsion 
Code-Independent - Maximal clear spacing 

6.2.3(3) - Maximal percentage of shear 
reinforcement 
9.2.2(5) - Minimal percentage of shear 
reinforcement 
9.2.2(6) - Maximal longitudinal spacing of 
stirrups (shear) 
9.2.2(8) - Maximal transverse spacing of 
stirrups (shear) 
9.2.3(3) - Maximal longitudinal spacing of 
stirrups (torsion) 

Column 

8.2(2) - Minimal clear spacing of bars 
9.5.2(1) - Minimal bar diameter of longitudinal 
reinforcement 
9.5.2(2) - Minimal area of longitudinal 
reinforcement 
9.5.2(3) - Maximal area of longitudinal 
reinforcement 
9.5.2(4) - Minimal number of longitudinal 
reinforcement bars 

9.2.3(3) - Maximal longitudinal spacing of 
stirrups (torsion) 
9.5.3(1) - Minimal diameter of transverse 
reinforcement 
9.5.3(3) - Maximal longitudinal spacing of 
transverse reinforcement 

Beam Slab 
8.2(2) - Minimal clear spacing of bars 
9.3.1.1(3) - Maximal bar distance of 
longitudinal reinforcement 

- 

 
 
 

 SECTION CHECK 
 
 
The Section check tools can be used in two different ways: with or without practical reinforcement inputted 
beforehand.  
 
Section check can be launched: 
 

• In the properties window for an individual check 
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• In the properties window for the Section Check – results service  
 

 
 
 
 

 With practical reinforcement 
 
 
Example 1: ‘beam_practical reinforcement SC.esa’ 
 
Section check can be opened from all individual checks.   
 
In this example, select Design > Concrete 1D > SLS reinforcement stress limitation check (SLS) and click on 
“Section check” in the Properties window: 
 
Select the beam and then click on the position for which the check should be done. Choose section 20 at the 
middle of the beam: 
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The Section check tool opens: 
 

 
 
 
 
This window is composed of 3 mains parts: 

- Definition / modification of the reinforcement 
- Preview of the report 
- Checks to be performed according to the previous selected combinations or load cases. By default, 

only the individual selected check will be performed. The user can activate more checks if wanted.  
 
When selecting a SLS combination in the Properties windows, only SLS checks will be available.  
When selecting a ULS combination in the Properties windows, only ULS checks will be available. 
 
In this example, stress limitation in the concrete is not OK. One solution is to redesign the longitudinal 
reinforcement to satisfy the SLS stress limitations. We could then close the Section check tool and change the 
practical reinforcement for this beam or we can adapt locally the reinforcement in the studied section (Section 
19). We will choose to adapt the reinforcement in the Section check tool itself. 
 
When practical reinforcement was already inputted, it can be edited in the tab “Reinforcement (free)”: 
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Each present bar, position and diameter, is listed in the table. They can be modified, deleted or new bars can 
be added. 
 
Increase the diameter of top layer bars B0, B1, B4 and B6 from 20mm to 25mm: 
 

 
 
 
 

 Without practical reinforcement 
 
 
Example 2: ‘beam_without practical reinforcement SC.esa’ 
 
When no practical reinforcement was inputted beforehand, it is possible to run the section check tool in order 
to check a specific section of a member with a local reinforcement on this specific section. 
 
In the Concrete menu, select “Section check results”. 
In the properties window, choose the ULS combination to perform all ULS checks: 
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Select Section 9, in the middle of the first span. 
All checks are not satisfied, and the overall UC is 3. The value 3 means that the check could not be performed 
due to an error in the calculation. In this case, it is because there is no reinforcement yet.  
 
We will start by inserting the reinforcement. First choose the reinforcement template: 
 
 

 
 
Then change the diameter of the reinforcement template. For bottom longitudinal bars, change diameter to 
20mm in the tab “Reinforcement (layout): 
 

 
Note that it is also possible to define the shear reinforcement in this window. 
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The results for all ULS checks are now: 
 

 
 
 
Once the section is reinforced and checks are satisfied, the user can save the design of this section with the 
option “Save and close”: 
 

 
 
A label will then be added on the beam: 
 

 
 
 
It is possible to run the Section check for SLS combination as below: 
 

 
 
 
If required, Section check tool can still be opened to redesign the section to satisfy the SLS checks by clicking 
on Section check in the Properties window.   
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 Column design 

 

 Reinforcement design methods 

 
For column design, there are 3 types of calculation: 

- Axial compression only 
- Uniaxial bending 
- Biaxial bending 

 
 
When taking a closer look at the column calculation, 2 different approaches can be distinguished: 

- For the ‘Axial compression only’ and ‘Uniaxial bending’ calculation, SCIA Engineer uses the 
same computing heart as for beams. 

- For ‘Biaxial bending’ calculations, SCIA Engineer uses a combination of the computing heart for 
beams and the so-called interaction formulas. 

 
 
Furthermore, the uniaxial bending calculation always has as result a 1-directional reinforcement configuration, 
with the same number of reinforcement bars at parallel sides. 
 
The biaxial bending calculation has as result a 2-directional reinforcement configuration. The number of bars 
may differ per direction, but is always the same for parallel sides: 
 

 
 
 
The uniaxial bending calculation is a relatively simple calculation type, while the biaxial bending calculation 
requires an iterative process. 
 
Keep this in mind as the reason why the uniaxial bending calculation will go a lot faster. 
 
 
 

 DESIGN WITH AXIAL COMPRESSION ONLY 
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 No reinforcement required: NEd < NRd 
 
 
Example: ‘Axial compression only.esa‘ 
 
Studied column: B1 
 
Geometry  
Column cross-section: RECT 350x350 mm² 
Height: 4,5 m 
Concrete grade: C45/55 
 
Concrete Setup 
Item Concrete settings > Internal forces ULS: ‘eccentricities’ are not taken in account. 
 

 
 
 
The Detailing provisions are not taken in account, in order to view the pure results (according to the Eurocode, 
always a minimum reinforcement percentage must be added). 
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Loads 
LC1: Permanent load > F = 1100kN 
LC2: Variable load > F = 1000kN 
This means the column is loaded with a single compression force.  
 
Combination according to the Eurocode: 
ULS Combination = 1,35 * LC1 + 1,50 * LC2 
Design normal force NEd = 1,35 * 1100 + 1,50 * 1000 = 2985kN 
 
Bar diameter 
The bar diameter is taken from the Concrete Settings > Complete setup View, or from 1D member data if 
applied (1D member data always overwrite the Concrete Settings data, for the specific member they are 
assigned to). 
 

 
 
 

By default, the diameter for the main column reinforcement is put to 16mm. Based on this diameter and the 
exposure class (by default XC3), the concrete cover is calculated. This information is necessary to be able to 
calculate the lever arm of the reinforcement bars. 
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Note: To change the default diameter from 16mm to 20mm for example, edit the template 
“Column_Rect_Empty” (or the corresponding empty template for the specific columns shape), and change the 
value of the diameter to be taken into account (additional provided reinforcement). 
 
Results 
Go to Steel workstation > 1D Reinforcement design : 
 

 
 
Ask the value of As reg for member B1, and click the action button [Refresh].  
 

 
 
 
The graph appears to be null on the screen. The Brief output (Preview button), gives As,req = 0. 
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If you set output settings on Detailed, you can see the explanation that reinforcement is not necessary. 
 

 
 
 

 
 
 
 
Remark : this result is obtained only because all detailing provisions are deactivated in the Concrete 
Settings ! 
 
Check of reinforcement 

NRd = fcd ·  · Ac = 30 * 1 * 3502 / 1000 = 3675kN 
 
Since NRd = 3675kN > NEd = 2985kN, indeed no theoretical reinforcement is required. 
 
 
 

 Reinforcement required: NEd > NRd 
 
 
Example: ‘Axial compression only.esa‘ 
 
Studied column: B2 
 
For this example, the same configuration as above is used, only the permanent point load is increased to 
2000kN.   
 
Loads 
LC1: Permanent load > F = 2000kN 
LC2: Variable load > F = 1000kN 
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Combination according to the Eurocode: 
ULS Combination = 1,35 * LC1 + 1,50 * LC2 
Design normal force NEd = 1,35 * 2000 + 1,50 * 1000 = 4200kN 
 
Results 
Remark that SCIA Engineer shows on the screen the reinforcement per direction. The total reinforcement area 
is in fact 750 + 750 = 1500mm2. 
 

 
 
 

 
 
 
When asking for the Standard output for Reinforcement design, the proposed configuration can be found: 
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Explanation of the number of reinforcement bars 
 

Default bar diameter has been set to 16 in Design default. 

The table indicates that each edge needs 316.  

On the final picture, this leads to a total of 816 in the section of the column.  
 
 
 

 DESIGN WITH BENDING MOMENT AND AXIAL FORCE 
 
 
Four calculation methods are available in SCIA Engineer in concrete settings > Design As > Beam, Column, 
Rib, … > Design method: 
 

• Auto (by default) 

• Uniaxial around y axis 

• Uniaxial around z axis 

• Biaxial (always used for circular and oval columns) 
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The “Auto” selection of the design method is based on the limit ratio of bending moment for the uniaxial method. 
The program will automatically select the uniaxial or biaxial method depending on the values of bending 
moments around y and z axis. 
 
Rule for automatic selection of the design method: 
 

• If ρM ≤ ρM,lim Uniaxial method                           ρM =
Min{|MEdy,max|,|MEdz,max|}

Max{|MEdy,max|,|MEdz,max|}
 

• If ρM ≥ ρM,lim Biaxial method                             
  
With: 

MEdy.max  maximal design moment around y axis from all combinations in current section 
MEdz.max  maximal design moment around z axis from all combinations in current section 
ρM,lim   limit ratio of bending moments for uniaxial method loaded from Concrete settings 

 
 
Settings for limit ratio: 
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 Uniaxial bending calculation 
 

 
 
Principle 
 
The reinforcement is designed for NEd and one bending moment MEd,y or MEd,z : 

• Uniaxial around y:  MEdz is ignored, the reinforcement is designed only for NEd and MEd,y 

• Uniaxial around z: MEdy is ignored, the reinforcement is designed only for NEd and MEd,z 
 
If Auto selection of design method is selected and ρM ≤ ρM,lim, the rule to choose between uniaxial method 
around y or z is: 

• If MEd,y  MEd,z → As = Asy is designed for forces NEd and MEd,y  

• If MEd,z  MEd,y → As = Asz is designed for forces NEd and MEd,z 
 
 
Example: open the example ‘Uniaxial bending.esa’ 
 
Geometry 
Column cross-section: RECT 350x350mm² 
Height: 4,5 m 
Concrete grade: C45/55 
 
Concrete Setup 
Item Concrete settings > Internal forces ULS: ‘eccentricities’ are not taken in account (only 1st order moments 
are considered). 
 

 

F

M

L
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Item Detailing provisions are not taken in account, to view the pure results (according to the Eurocode, always 
a minimum reinforcement percentage must be added). 
 

 
 
 
Loads 
Column B1: 
LC1: Permanent load > F = 500kN; My = 100kNm 
LC2: Variable load > F = 1000kN; My = 100kNm 
 
Column B2: 
LC1: Permanent load > F = 500kN; My = 100kNm 
LC2: Variable load > F = 1000kN; My = 100kNm; Mz = 10kNm 
 
Combination according to the Eurocode: 
ULS Combination = 1,35 * LC1 + 1,50 * LC2 
Design normal force NEd = 1,35 * 500 + 1,50 * 1000 = 2175kN 
Design moment Myd = 1,35 * 100 + 1,50 * 100 = 285kNm 
Additional design moment in column B2 Mzd = 22,5kNm  
 
Results 
Go to Reinforcement design > 1D members > Reinforcement design, ask the value for As,req, and click the 
action buttons [Refresh] and [Preview].  
 
Looking at the Detailed output for column B1: 
 

 
 
The numerical results of the calculation are as follows (standard output): 
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Looking at the Detailed output for column B2: 
 

 
 
 
And the Standard output: 
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Even if an additional bending moment in the z direction is present in column B2, according to the limit ratio the 
uniaxial method was used, and the same amount of reinforcement is required for columns B1 and B2. 
 
The user has the possibility to force the biaxial method design on column B2 using 1D member data in 
Concrete menu > Concrete 1D data: 
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Amount of required reinforcement will be slightly higher in this case since MEdz is also considered. 
 

 
 
 

 Biaxial bending calculation 
 

 

F

My

L

Mz
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This method allows to design reinforcement for a normal force (NEd) and biaxial bending moments. This method 
is based on an interaction formula, equation 5.39 in EN 1992-1-1. 
 

  (
MEdz

MRdz
)

a

+ (
MEdy

MRdy
)

a

≤ 1,0        (5.39) 

 
where: 

MEdz/y design moment, including a 2nd order moment (if required) 
MRdz/y moment resistance 
a  exponent: 

- for circular and elliptical cross sections: a = 2 
- for rectangular cross sections: 

 
with linear interpolation for intermediate values 

 
NEd design value of axial force 
NRd  = Ac ∙ (fcd + μs ∙ fyd), design axial resistance of the section, where: 

Ac gross area of the concrete section 
fcd  design value of concrete compressive strength 
fyd  design yield strength of reinforcement 
μs  mechanical reinforcement ratio in the calculation of limit slenderness obtained with an 

iterative calculation 
 
 
 

 CIRCULAR COLUMN 
 
 
For circular and oval columns, the design method is always the biaxial calculation, regardless of the design 
method set in the Concrete settings. 
 
For circular and oval columns, the required number of reinforcement bars is spread equally along the face of 
the column. 
 
 
Example: ‘Circular column.esa’ 
 
Geometry 
Column cross-section: CIRC diameter 400mm 
Height: 4,5 m 
Concrete grade: C45/55 
 
Loads 
Load configuration:  NEd = 2175,00kN 

Myd = 142,50kNm 
Mzd = 0kNm 

 
Concrete Setup 
Geometrical imperfection and 2nd order moments are deactivated: Concrete settings > Complete Setup view : 
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All detailing provisions are considered.  
 
 
Design defaults 

The bar diameter is set to 20mm in Reinforcement design > Design defaults > Tab Columns, or from 1D 
Member data if applied. 
 

 
 
 
Results 
Go to Reinforcement design > 1D members > Reinforcement design. 
Choose Standard output in the Properties window and open the Preview at the bottom of the Properties 
window: 
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In this example As,req is determined by the minimum amount of reinforcement according to the detailing 
provision, As,det,min. 

Since As,req = 1257mm², the software will propose 5 bars of 20mm (5*314mm² = 1571mm² = As,req,bar) which 
is the closest amount of bar with As,req,bar > As,req. 
 
Note that SCIA Engineer uses the real area of the bars to calculate the required reinforcement area. 
So, the final required reinforcement displayed on the screen is As,req,bar. 
 
Remark 1: If you choose a template without bars predefined in Design Default, for example “Column_Circ-
Empty”, the software will display only the As,req and not As,req,bar as mentioned above.  
 

 
 
 
Remark 2: 
According to EN1992-1-1 art 9.5.2(4), there is a minimum number of bars in a circular column.  
This parameter is set by default to “4” in Concrete Settings > Complete setup view.  
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If we increase the loads:  

Fz = -1250kN 
M = 50kNm  

The results are as follows: 
 
 
Exemple: “Circular column_increase.esa” 
 
 

 
 
The corresponding bar configuration is: 
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 Calculation of internal forces 

 
 
 

 DETERMINING IF MEMBER IS IN COMPRESSION 
 
 
2nd order effects, geometrical imperfection and minimal eccentricity are considered only if: 

- Member type = Column 
- Compression in the column is relatively high 

 
In SCIA Engineer, there is a parameter which allows to decide whether a member is in compression or if the 
compression is too small to be considered.  
 
In Concrete settings > Complete setup view : 
 

 
 
 
 
Condition is: 

• If NEd ≤ - Coeffcom * fcd * Ac  Member is in compression 

• If NEd > - Coeffcom * fcd * Ac Compression is not sufficient (zero or relatively small) 
 
 
This result can be viewed in Reinforcement design > 1D member > Internal forces. 
 
The Detailed output gives: 
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 CHOICE BETWEEN 1st and 2nd ORDER CALCULATION 
 
 
Slenderness – Check of the criteria λ < λlim 
 

• If  < lim, 1st order effects have to be taken into account with geometric imperfection (art 5.2) 

• If  > lim, 2nd order effects have to be taken into account with geometric imperfection (art 5.2) 
 
 

The values for  and lim, and the corresponding check, can be found in the main menu Deign > Concrete 1D 
> Slenderness for design : 
 
 

 
 
 
 

The Standard output shows the check of  > lim and indicates whether a 1st or 2nd order calculation should be 
done. 
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 1st ORDER EFFECTS 
 
 
1st order effects (eccentricity) are always considered.  
 
There are 2 ways to calculate the 1st order moments and eccentricity in SCIA Engineer depending on check 
box First order eccentricity with the equivalent moment in Concrete Setup > Solver setting > Internal 
forces. 
 

 
 
 
The 2 options are: 
 

• First order eccentricity with the equivalent moment = YES, bending moments at the ends of 
the column will be taken to calculate an equivalent 1st order bending moment. This leads to the 
same 1st order bending moment along the whole length of the member. 

e0y = M0ez/NEd et  e0z = M0ey/NEd 

With  
   M0e = (0,6 ∗ M02) + (0,6 ∗ M01) ≥ 0,4 ∗ M02     

 

• First order eccentricity with the equivalent moment = NO, 1st order eccentricity is calculated 
from bending moments in current section. As a result, bending moments in each section can be 
different. 

e0y = Mz/NEd et  e0z = My/NEd 

 
 
Values of the 1st order eccentricities and moments can be viewed in Design > Concrete 1D > Internal forces 
for design. 
 
 
Standard output gives: 
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 GEOMETRICAL IMPERFECTION (art 5.2) 
 
 
The effect of geometric imperfections always have to be taken into account: both in a 1st and 2nd order 
calculation. 
 
Geometrical imperfection is by default activated in Concrete settings > Internal forces  
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In SCIA Engineer, the geometrical imperfection is represented by an inclination according to clause 5.2(5) in 
EN 1992-1-1.  
 
For both axis (y and z of LCS), the inclination is calculated as followed: 
 

    (5.1) 
 
θ0  basic value of inclination 
αh  reduction factor for length of column or height of structure:  
αm,y(z) reduction factor for numbers of members:  
l   length of column or height of structure depending on: 

- isolated member l = L, where L is the length of the member 
- not isolated member l = H, where H is the total height of building (buckling system). 

 
my(z) number of vertical members contributing to the total effect of the imperfection perpendicular 

to y(z). 
 
Values of l and my(z) will be defined in the buckling data. 
 
The effect of imperfection for isolated column and for structure is always taken into account as an eccentricity 
according to clause 5.2(7a) in EN 1992-1-1: 
 

 
 
The imperfection shall be taken into account in ultimate limit states and does not need to be considered for 
serviceability limit states, see clause 5.2(2P) and 5.2(3) in EN 1992-1-1.  
The user can set independently if the imperfection will be taken into account for ULS or SLS in the Concrete 
settings. 
 
 
A minimum 1st order eccentricity is also calculated according to clause 6.1(4) in EN 1992-1-1.  
This can be viewed in Concrete settings > Internal forces > Use minimum value of eccentricity 
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Buckling data for l and my(z) 
 
Settings for l and my(z) for the calculation of the geometrical imperfection can be set in the properties of the 
columns. 
 
Properties > System lengths and buckling settings  
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When opening the buckling menu, you need to define both the ‘Active buckling constraints’ and ‘Span 
settings’ for buckling around the local y-axis (buckling span y-y) and local z-axis (buckling span z-z).   
 

• Total height determination: set type of calculation of total height of building or length of the 
isolated columns. 

o Calculate: H tot will be calculated automatically as sum of lengths of all the members in 
the buckling system 

o Input: manual input value for Htot in edit box Tot. height 

• my/z: number of vertical members contributing to the total effect of the imperfection 
perpendicular to y/z axis of LCS. 

    
 
Eccentricities due to geometrical imperfections can be viewed in Reinforcement design > 1D member > Internal 
Forces: 
 

 
 
After calculation of 1st order eccentricity including effect of imperfection, the 1st order moment, including the 
effect of imperfections around y (z) axis of LCS is calculated: 
 

   
 
 
e0,y(z)  1st order eccentricity 
ei,y(z)  eccentricity caused by geometrical imperfection 
e0,min    minimum first order eccentricity 
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 2nd ORDER EFFECTS 
 
 
The EN 1992-1-1 defines several methods for 2nd order effects with axial loads(general method, simplified 
method based on nominal stiffness, simplified method based on nominal curvature...).  
 
In SCIA Engineer the following methods are available:  

• General method according to clause 5.8.2(2) – based on a nonlinear calculation 

• Simplified method based on nominal curvature according to clause 5.8.8 
 
 
The simplified method is taken into account: 

• For ultimate limit state 

• For Member type = Column with compression according to "Determination if member is in 
compression" 

• If option “Use second order effect” in switched ON, see Concrete settings > Internal forces. 
This option is activated by default. 

• If slenderness  > lim, see chapter "Slenderness criteria" 
 
 
The nominal 2nd order moment is calculated according to clause 5.8.8.2(3) in EN 1992-1-1: 

M2,y(z) = NEd ∗ e2,z(y) 

 
With: 
 

NEd  design axial force 
e2,z(y)  2nd  order eccentricity 

 
When all mentioned criteria above are met for the simplified method, the 2nd order eccentricity is calculated 
according to formula: 

 
 
Otherwise : 

e2,y(z)=0 

With : 
 
(1/r)z(y)  curvature around z(y), calculated according to clause 5.8.8.3 
l0,z(y)  effective length of the column around z(y) – buckling length 
cz(y)  factor depending on the curvature distribution around z(y) axis according to clause 5.8.8.2(4) 

• = 8, for constant 1st order bending moment (non zero) along the column and in case 
that equivalent bending moment is taken into account (“Use equivalent first order 
value” ON). 

• = 10 otherwise. 
λz(y)  slenderness 
λz(y),lim  limit slenderness 
 
 
 
Effective length 
 
The effective length, or buckling length, is by default calculated by SCIA Engineer. Be aware that formulas for 
automatic calculation are only valid for simple structures!  
Otherwise it is also possible to input the value of the effective length manually. 
 
 
Automatic calculation of effective length 
 
Calculation of effective length depends on the type of structure, sway or non-sway.  
 
Two approximate formulas are used: one formula for a non-sway structure (resulting in a buckling factor β ≤ 
1) and one formula for a sway structure (resulting in a buckling factor β ≥ 1): 
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• For a non-sway structure: 
 

𝛽 =
(𝜌1𝜌2 + 5𝜌1 + 5𝜌2 + 24)(𝜌1𝜌2 + 4𝜌1 + 4𝜌2 + 12)2

(2𝜌1𝜌2 + 11𝜌1 + 5𝜌2 + 24)(2𝜌1𝜌2 + 5𝜌1 + 11𝜌2 + 24)
 

 

• For a sway structure: 
 

𝛽 = 𝑥√
𝜋²

𝜌1𝑥
+ 4 

 
with β 

L 
the buckling factor 
the system length 

 E the modulus of Young 
 I the moment of inertia 
 Ci the stiffness in node i 
 Mi the moment in node i 
 i the rotation in node i 

   

𝑥 =
4𝜌1𝜌2 + 𝜋²𝜌1

𝜋2(𝜌1 + 𝜌2) + 8𝜌1𝜌2

 

𝜌𝑖 =
𝐶𝑖𝐿

𝐸𝐼
 

𝐶𝑖 =
𝑀𝑖

𝜙𝑖

 

 

The values for Mi and i are approximately determined by the internal forces and the deformations, calculated 
by load cases which generate deformation forms, having an affinity with the buckling form. 
 
The calculation of the β ratios is automatically done when calculating the structure linearly. For this, two 
additional load cases are calculated in the background: 
 

• Load case 1: 
o on the beams, the local distributed loads qy=1 N/m and qz=-100 N/m are used 
o on the columns the global distributed loads Qx =10000 N/m and Qy =10000 N/m are 

used. 

• Load case 2: 
o on the beams, the local distributed loads qy=-1 N/m and qz=-100 N/m are used 
o on the columns the global distributed loads Qx =-10000 N/m and Qy=-10000 N/m are 

used. 
 
 
Since these load cases, and thus the buckling ratios, are calculated during the linear calculation, it is necessary 
to always perform a linear calculation of the structure. 
 
Note: The used approach gives good results for frame structures with perpendicular rigid or semi-rigid beam 
connections. For other cases, the user must evaluate the presented bucking ratios. 
 
 
By default, the structure is considered as sway in y and z direction. It can be modified for the whole project in 
Concrete settings > General > Default sway type. 
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You can easily modify these default settings for a specific column in the project within the buckling menu. This 
menu can be accessed – as explained in the previous section – by navigating to the option ‘System lengths 
and buckling settings’ within the properties of the member.  
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This new setting has the name, here BG1, which you can attribute to others similar columns in their properties 
window: 
 

 
 
 
The calculated effective length can be viewed in Design menu > Concrete 1D > Slenderness for design: 
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Manual input of effective length 
 
The same option – as seen for the automatic calculation – allows you to manually define the buckling length 
of the system. The option ‘Buckling length factors’ can be accessed within the section ‘Span settings’. In 
the table ‘Settings per span for y-y/z-z axis’ you can insert the buckling length which needs to be taken into 
account.  
 

 
 
 
 

 RECALCULATED INTERNAL FORCE 
 
 
In Concrete Menu > Reinforcement Design > 1D member > Internal forces. 
 
The design moment, MEd, is equal to MEd = M0Ed + M2. 

 
With : 
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M2 2nd order bending moment 
M0Ed bending moment taking into account 1st order and geometrical imperfections 
 
 
Example: ‘2nd order.esa’ 
 
Geometry 
Column cross-section: RECT 350x350mm² 
Height: 4,5 m 
Concrete grade: C45/55 
 
Concrete Setup 
All of the default values are kept. 
This means that geometrical imperfection and 2nd order effects are taken into account. 
 
Loads 
Load configuration:  Nd = 405,00kN 

Myd = 40,50kNm 
Mzd = 0kNm 

 
Buckling data 
Sway type is set by default. 
Calculation of the effective length is done automatically by the software. 
 
 
Slenderness criterion 
Check if 2nd order calculation is required following art 5.8.3.1: 
 
Since λ > λlim, a 2nd order calculation will be required. 
 
Note: the program automatically takes into account a second order moment if required. So, this check is just 
extra information for the user. 
 
Internal forces 
Ask for MEd in Design > Concrete 1D > Internal forces for design. 
The Standard output is chosen: 
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Results 
The results for the reinforcement design are shown below: 
 

 
 
 
Note that biaxial bending method was used for reinforcement calculation.  
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 Plate design 

 

 

 Used example 

 
 

 INPUT OF GEOMETRY 
 
 
Project data: 2D environment = Plate XY 
 

 
  
The Reinforcement material (e.g. B500A) chosen in the Project data window, will define the steel quality used 
for the theoretical reinforcement design. 
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Properties of the slab and the line supports: 
 

 
 

 
 
 

 LOADS 
 
 

 Load cases & Load groups 
 
 

Load Case Action type Load Group Relation EC1-Load type 

Self-weight Permanent LG1 / / 
Walls Permanent LG1 / / 

Service load Variable LG2 Standard Cat B: Offices 
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 Load combinations 
 
 
Type EN-ULS (STR/GEO) Set B 
Type EN-SLS Quasi Permanent 
 

 
 
 

 Result classes 
 
All ULS+SLS 
 

 
 
 
 

 FINITE ELEMENT MESH 
 
 

 Introduction 
 
2 types of finite elements are implemented in SCIA Engineer: 
- The Mindlin element including shear force deformation, which is the standard in SCIA Engineer. The Mindlin 
theory is valid for the calculation of both thin and thick plates. 
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- The Kirchhoff element without shear force deformation, which can be used to calculate and design only thin 
plates. 
 
The element type used for the current calculation is defined in the tools menu > Calculation & Mesh > Solver 
Settings: 
 

 
 
 

 Mesh generation 
 
Via the tools menu → Calculation & mesh → Generate mesh  
 
 

 Graphical display of the mesh 
 
Set view settings for all entities, via right mouse click in screen or more options > View settings for all entities 
 

 
 
- Structure tab → Mesh → Draw mesh 
- Labels tab → Mesh → Display label 
 
 

 Mesh refinement 
 
Via the tools menu → Calculation & mesh → Mesh settings 
Average size of 2D (mesh) elements is by default = 1m. 
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OR 
 
The mesh size can be changed in the FE analysis window before running the calculation. 
 

 
 
 
‘Basic rule’ for the size of 2D mesh elements: take 1 to 2 times the thickness of the plates in the project. For 
this example, take a mesh size of 0,25 m. 
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 Results for the linear calculation 

 
 
 

 SPECIFICATION OF RESULTS 
 
 
After running the linear calculation, go to the Results menu → 2D members → 2D Internal Forces. 
Specify the desired result in the Properties menu: 
 
 



Advanced Concept Training – Concrete 

126  MJA / TC – 2023/01/16 

 
 
 
System: 

- LCS mesh element: according to the local axes of the individual mesh elements 
- LCS - Member 2D: according to the LCS of the 2D member (Pay attention when working with shell   

elements!) 
 

Location: 4 different ways to ask for the results, see chapter Results 
Type forces: Basic, Principal or Design magnitudes, see Annex 1 

Drawing setup 2D: Click on the button . Here you can modify the display of 2D results (Isobands / Isolines 
/ Numerical results / ...), modify the minimum and maximum settings, ... 
 
After making changes in the Properties menu, you always have to execute the ‘Refresh’ action. 
 
 
 
 

 TYPES OF RESULTS 
 
 

 Basic magnitudes 
 
Combination = ULS; Type forces = Basic magnitudes; Envelope = Minimum; Values = m_x 
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These are the characteristic values coming from de FE-analysis in the center of the plate. 
 
 

 Elementary design magnitudes 
 
Combination = ULS; Type forces = Design magnitudes; Envelope = Maximum; Values = m_xD+ 
 

 
 

The convention for the sign of the design moments has been changed since the v17 post-processor. Now a moment is positive when 
it causes a tensile force on the bottom of the plate and negative when it causes tensile force at the top of the plate. 
 
In the v16 post-processor a design moment is positive when you should reinforce for this moment. This means that for a positive value 
for m_xD+ there is a tensile force at the top of the plate and that for a positive value for m_xD- there is a tensile force at the bottom of 
the plate. 

 
The available values are mxD, myD and mcD, where ‘D’ stands for design. The ‘+’ and ‘-‘ respectively stand 
for the values at the positive and negative side of the local z axis of the 2D member. 
So for instance the value mxD+ is the moment that will be used for the design of the upper reinforcement in 
the local x-direction of the 2D member. 
 
The calculation of design moments for plates and shells according to the EC2 algorithm follows the chart from 
CSN P ENV 1992-1-1, Annex 2, paragraph A2.8. 
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What happens, is that for the 3 characteristic (bending and torsion) moments an equivalent set of 3 design 
moments is calculated: 
 

mx   mxD 

my         ≈  myD 

mxy   mcD 
 
 
It is clear that mxD and myD are the moments to be used for the reinforcement design in the respective 
direction. The quantity mcD is the design moment that has to be taken by the concrete. The Eurocode does 
not mention any check for this value, but it is however available in SCIA Engineer for the reason of 
completeness. 
 
 
The calculation of design forces for walls according to the EC2 algorithm follows the chart from CSN P ENV 
1992-1-1, Annex 2, paragraph A2.9. 
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Analogously, if membrane effects are present, for the 3 characteristic membrane forces an equivalent set of 3 
design forces is calculated: 
 

nx   nxD 

ny         ≈  nyD 

nxy   ncD 
 
 
Here, the quantity ncD does have a clear meaning: it is the compression force that has to be taken by the 
concrete compression struts. Therefore, to make sure that concrete crushing will not occur, the value ncD 
should be checked to be ≤ fcd.  
 
Attention: These design magnitudes are not the ones used by SCIA Engineer for the reinforcement design in 
the Concrete menu. A much more refined transformation procedure is implemented there to calculate the 
design magnitudes from the basic magnitudes. 
 
 

 Principal magnitudes 
 
Results menu → 2D members → 2D stresses/strain 

Combination = ULS; Type forces = Principal stress; Envelope = Maximum; Values = 𝜎1+ 
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‘1’ and ‘2’ refer to the principal directions, calculated based on Mohr’s circle. 
The first direction is the direction of maximum tension (or minimum compression). The second direction is the 
direction of maximum compression ( or minimum tension). 
 
Keep in mind that the most economic reinforcement paths are the ones that follow the trajectories of the 
principal directions! 
 
 
 

 COMPARISON MINDLIN  KIRCHHOFF 
 

 
 Shear force vx 

 
 
Combination = ULS; Type forces = Basic magnitudes; Envelope = Maximum; Values = v_x 
 
Mindlin 

Section at lower edge 

   Mesh size = 0,25 m 
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   Mesh size = 0,05 m 
 
Kirchhoff 

Section at lower edge 

   Mesh size = 0,25 m 

   Mesh size = 0,05 m 
 
 
 
 

 Torsion moment mxy 
 
Combination = ULS; Type forces = Basic magnitudes; Envelope = Maximum; Values = m_xy 
 
Mindlin 

Section at lower edge 
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   Mesh size = 0,25 m 

   Mesh size = 0,05 m 
 
Kirchhoff 

Section at lower edge 

   Mesh size = 0,25 m 

   Mesh size = 0,05 m 
 
 
Conclusion: Kirchhoff gives the expected shear force values, Mindlin gives the expected torsion moments. 
 
 

 

 Concrete setups 

 
 

 GENERAL SETUPS 
 
 

 Setup 1: National Determined parameters 
 
File → Project settings → National annex […] → EN 1992-1-1 […] 
 
OR 
 
Click on the flag at the top right of SCIA Engineer → Manage annexes → EN 1992-1-1 […] 
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 Setup 2: Concrete settings 
 
Concrete menu → Concrete settings 
 

 
 
All of the adjustments made in one of the two general setups are valid for the whole project, except for the 
members to which ‘Member data’ are added. 
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 MEMBER DATA 
 
 
It is possible to overwrite the data from the general setups per 2D member, namely by means of Member 
data; see Concrete menu – Concrete 2D data. 
 

 
 
On a plate with Member data appears a label, e.g. CMD1 (= Concrete member data). This label can be selected 
at any time to view or to adapt the data via the Properties menu. Since Member data are additional data, it is 
possible to copy them to other plates, via the edit menu > metadata > copy or via a right mouse click. 
 

 
 
 
 

 ULS design 

 
 

 REINFORCEMENT DESIGN 
 
 

 Internal forces 
 
Design menu → Concrete 2D → Internal forces 
 
Basic (centroid) : the values shown here are exactly the same as in the Results menu; they are calculated by 
the FEM solver. 
 
Design (centroid) : the values shown here are different from those in the Results menu. 
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- The design magnitudes in the Results menu are calculated by the FEM solver according to some simple 
formulas specified in EC-ENV. 
- The design magnitudes in the Concrete menu are calculated by the NEDIM solver, where a much finer 
transformation procedure is implemented, based on the theory of Baumann. 
These are the values that will be used for the SCIA Engineer reinforcement design. 

 
 
 
Theory of Baumann: 
 

1) Calculation of the lever arm. 
 
The lever arm is necessary for the calculation of surface forces. Value z will be calculated in the direction of 
the angle of the first principal moment. The forces will be recalculated and a cross-section set will be created 
in this direction. The reinforcement will be designed for these recalculated forces and from the designed 
reinforcement the inner lever arm will be calculated. 
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If value z cannot be calculated it will be calculated according to formula: z = 0,9 * d 
 

2) Calculation of normal forces at the surfaces of 2D element. 
 

The inputted internal forces will be recalculated to both surfaces according the following formulas: 
 

 
 
 

3) Calculation of principal forces at surfaces of 2D element. 
 
The principal forces at both surfaces and the direction of the first principal force will be calculated according to 
the following formulas: 
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4) Recalculation of principal forces at both surfaces to inputted directions. 
 
The recalculation of the principal forces to the inputted direction will be done separately for both surfaces by 
using Baumann’s transformation formula. 
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5) Calculation of virtual forces at both surfaces to inputted directions. 
 
The virtual forces are necessary to convert the pressure/tensile forces at the surface back to the center of the 
plate. The virtual force represents the equivalent force at the other side of the plate.  
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6) Recalculation of forces at surfaces to center of gravity of cross-section. 
 
Using the transformed dimensional forces and virtual forces the internal forces at the center of the plate can 
be calculated. 
 

 
 
 
The available values are: mEd,1+, mEd,2+, mEd,c+, mEd,1-, mEd,2-, mEd,c-, nEd,1+, nEd,2+, nEd,c+, nEd,1-
, nEd,2-, nEd,c- and vEd. “+” and “-“ stand for the design values at respectively the positive and the negative 
side of the local z-axis of the 2D member. “1” and “2” stand for the reinforcement directions, which are by 
default respectively the local x- and y- direction of the 2D member. (mEd,c+ and mEd,c- are the design 
moments that would have to be taken by the concrete, but they have no real significance for the reinforcement 
design.) 
 



Advanced Concept Training – Concrete 

140  MJA / TC – 2023/01/16 

Combination = ULS; Type values = Design internal forces; Value = mEd,1+ 
 

 
 
 
Compare the result for this value mEd,1+ (Concrete menu) with the result for the equivalent value mxD+ 
(Result menu) shown on p.128.  
Despite the different transformation procedures, the general image of the results will be similar for orthogonal 
reinforcement directions (acc. to the local x and y axes). The largest difference is caused by the shift rule that 
is only taken into account in the design magnitudes calculated by the NEDIM solver (values mEd,1 and mEd,2). 
 
 
The shift rule takes into account the additional tensile force caused by the shear force by shifting the moment 
line by a distance ai. ai is determined as in the image below. 
 

 
 
The shift rule is taken into account in the default concrete settings. You can deactivate this option in the 
concrete settings.  
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If we uncheck this option the general image of mEd,1+ is closer to the one obtained for mxD+ (page 128). 
 

 
 
 

 Provided reinforcement 
 
Before calculating the theoretical reinforcement it is possible to add a template of reinforcement to your 
plate(s). This template can be used to: 

- Compare the template with the calculated theoretical reinforcement. By doing this it is easy to see 
where this basic template is not sufficient. 

- Perform the punching design, Crack width check and the code dependent deflections.  
 
The reinforcement added by the template is called Provided reinforcement.  
 
To add Provided reinforcement go to Concrete menu → Concrete settings → Design defaults 
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Click on the 3 dots next to the ‘Design template of provided reinforcement’. This opens a window with all the 
default templates.  
 

 
 
 
You can select one of these templates, make a new one or edit one of the existing templates. Select the first 
template and click ‘Edit’.  
 



Chapitre 2:  Design and Check 

MJA / TC – 2023/01/16  143 

 
 
 
In this window the reinforcement can be defined. There are 2 types of reinforcement in templates: 

 
- Basic reinforcement: This type of reinforcement is added over the entire plate.  
- Additional reinforcement: This type of reinforcement is only added in zones where, according to the 

calculated theoretical reinforcement , extra reinforcement is needed. You can define a single diameter 
and spacing as extra reinforcement. Or a list of reinforcement with either various diameters or various 
spacings. 

 
Note:  

 
- The diameter used for the Additional reinforcement is used also to perform the calculation of the 

theoretical required reinforcement. 
- In the design defaults you can change the reinforcement directions. These directions are respected 

by as well the provided as the theoretical required reinforcement. 
 

 
 
 
 

 Theoretically reinforcement 
 

Concrete Menu→ ULS & SLS 2D Reinforcement design  
 
In the menu Reinforcement design (ULS) you have 4 types of values: 
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- Required: These values represent the theoretical reinforcement calculated by SCIA Engineer. This 

takes into account the detailing provisions.  
 

 
 
 

 
 

As,req1+: Theoretical required reinforcement on the top side of the plate (positive z direction) in the 
first reinforcement direction. Taking into account the detailing provisions. 

 
 

- Required (statically): These values represent the theoretical reinforcement calculated by SCIA 
Engineer without the detailing provisions taken into account. 
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As,stat1+: Theoretical required reinforcement on the top side of the plate (positive z direction) in 
the first reinforcement direction. Without taking into account the detailing provisions. 
 

- Required (additional): These values show if there is extra reinforcement needed on top of the 
provided reinforcement. Areas where this value is 0 are areas where no extra reinforcement is 
needed (compared to the provided reinforcement). Areas where these values are not 0 are areas 
where the provided reinforcement is not sufficient.  

 

 
 

As,add,req1+: Theoretical additional required reinforcement on top of the provided reinforcement on 
the top side of the plate (positive z direction) in the first reinforcement direction. 
 

- Provided: These values show you the provided reinforcement defined in the templates. 
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As,Prov1+: Provided reinforcement on the plate. If elements are red the additional reinforcement in 
the template is not sufficient. 

 
 

 Calculation of longitudinal reinforcement 
 
The theoretical longitudinal reinforcement is calculated out of the design internal forces. 
 

 
 
 

 
=> Calculation of shear reinforcement 

 

Before calculating the shear reinforcement two checks are done: 

- VEd ≤ VRd,max : The design internal forces on the plate should be lower or equal to the maximum shear 
resistance of the plate.  
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- VEd < VRdc : If VEd is smaller than VRdc no shear reinforcement is required. If this is not the case punching 
shear reinforcement will be automatically calculated by SCIA Engineer. 

 

 
 

 
 
 
 
When VEd > VRd,max the following error appears in the output of the reinforcement design. 
 

 
 
This error message is found at locations with high peak values for the shear stress. Most of the time these 
peak values are singularities, and do not occur in reality. You have roughly 2 options: you can just ignore the 
peaks or average them, for example by means of Averaging strips. 
 
 
 

 Practical reinforcement design 
 
 
Next to theoretical required and provided reinforcement you have also practical or User reinforcement. This 
type of reinforcement can be added to the plate via the Concrete menu→ 2D Reinforcement.  
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This reinforcement is to be added separately at the upper and lower side, and in the different reinforcement 
directions. 
 

 
 
 
Note: You can add multiple layers of practical reinforcement on the same area. The reinforcement added to 
this area is the sum of all these layers. 
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 Combination Provided reinforcement and user reinforcement  
 
After running the reinforcement design, it might be possible the provided reinforcement is insufficient in certain 
areas. This means the user should introduce some additional reinforcement. In this case the user can apply 
two different workflows:  

(a) Define all the reinforcement as practical reinforcement; 
(b) Combine the provided reinforcement and the practical reinforcement which will only be 
defined in the areas where it is necessary to define additional reinforcement.  

This principle will be explained by using the following example for the ULS reinforcement design in direction 
1 or the local x-direction. Within the design defaults, the user can define a template for the provided 
reinforcement which can be used within the actual design. In this case the basic reinforcement will be set to 
Ø10 à 150 and the addition reinforcement will be set to zero.  
 

 
 
When running the ULS design for the value As_prov,1-, it can be seen the provided reinforcement of Ø10 à 
150 will be insufficient to withstand the acting loads. This indicates the application of additional reinforcement 
will be necessary.  
 

 
 
When generating the value As_add,req,1-, the user can see the exact amount of reinforcement in mm2/m 
which needs to be added on top of the provided reinforcement. In this case an additional reinforcement of 578 
mm2/m will be necessary. This value can be translated into the configuration of Ø10 à 100 as practical 
reinforcement. 
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This value can be translated into the configuration of Ø10 à 100 as practical reinforcement. Since there is no 
required additional reinforcement in direction 2, only one direction of reinforcement will be added to the 2D 
member by using practical reinforcement as defined within the previous section.  
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When generating the results once more for the value As_prov,1- and activating the option ‘Consider user 
reinforcement’, it can be seen the user defined reinforcement of Ø10 à 100 is added on top of the basic 
reinforcement of Ø10 à 150 which is defined within the design defaults. 
 

 
 

 
 
 
The applied values are visible within the preview of the reinforcement design.  
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The option ‘Consider user reinforcement’ is also accessible within all the reinforcement checks – crack width, 
punching and CDD. This allows the user to easily check the reinforcement introduced by both the template 
and the practical bars. 
 
 

 

 SLS Design of 2D members – Crack width and stress limitation 

 
 
Next to the ULS design of 2D members the Eurocode defines some restrictions related to SLS design as well, 
more specifically the crack width and the limitation of the tensile stress in the reinforcement. Due to these SLS 
conditions the user might need to increase the amount of reinforcement which should be sufficient to withstand 
the acting ULS forces. The total amount of reinforcement to fulfill the conditions for both the ULS and SLS 
design can be calculated within SCIA as well as the increment of statically required reinforcement.  
 
The principle of this design method will be explained by the following example of a 2D plate. On this member 
CMD will be applied in which the crack width in the first direction at the bottom surface will be limited to 0,100 
mm. The tensile stress in the reinforcement can be limited both within the design defaults and the CMD. In 
this example the limit will be set to 150 MPa.  
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Since this design method is applicable for the ULS and SLS, it is important to select a result class which 
contains both ULS and SLS combination.  
 

 
 
 
 
The first step of the design procedure consists of the determination of As_req for the ULS state for each 
direction and each surface. During this step SCIA will determine two values, more specifically:  
 (a) As_ult: the statically required reinforcement to withstand the ULS acting forces. 
 (b) As_req: the required reinforcement including the detailing provisions from the EN.  
 
When looking at the given example, it can be seen the required reinforcement As_req,1- is equal to 1614 
mm2/m. The statically required reinforcement As_ult,1- is equal to 1102 mm2/m. This value is a bit lower 
since it does not contain the increment of longitudinal reinforcement due to the SLS design.  
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After the calculation of As_ult the user can choose to integrate the SLS restriction and has got three 
possibilities: 

• Combination of the ULS and SLS design based on cracks.  

• Combination of the ULS and SLS design based on stress limitation. 

• Combination of the ULS and SLS design based on cracks and stress limitation.  
 

This can be defined within the properties of the reinforcement design.  
 

 
 
After activating these settings the increment of longitudinal reinforcement can be generated, in this case the 
value ∆As_serv,1-. SCIA will determine the principal forces mEd,ch and mEd,QP in order to calculate the 
appearance of cracks based on the designed ULS reinforcement As_ult. Next to the principal forces it is also 
necessary to calculate the amount of reinforcement in the direction of the principal forces. 
Within the following step, SCIA will determine the maximum allowable crack width based on chapter 7.3.4 from 
EN 1992-1-1:2004 and compare it to the defined limit as shown below.  
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If the cracks are within the limit, then As_ult is sufficient to fulfill the restrictions for both ULS and SLS. If not, 
then SCIA will start the iteration process to increase the As,ult by an extra amount of reinforcement to ensure 
the crack width is within the allowable limits. When looking at the table below it can be seen an additional 
amount of 1166 mm2/m for the first direction at the bottom of the member should be added to the reinforcement 
As_ult,1-.  
 

 
 
When looking at the output for ∆As_serv,1- a value of 562 mm²/m can be generated.  
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If this value of ∆As_serv,1 will be added to the value of As_ult,1-, it will result in the value As_req,1-.  In short 
the following summary can be created: 
 

• As_req,i,+/-: Required reinforcement area for ULS and SLS including detailing provisions for the 
particular direction (1,2) and surface (+,-). 

• As_ult,i,+/-: Statically required reinforcement based on ULS for particular direction (1,2) and 
surface (+,-). 

• ∆As_serv,i,+/-: Increment of statically required reinforcement based on SLS for particular direction 
(1,2) and surface (+,-). 

 
The same procedure can be applied for the limitation of tensile stress within the reinforcement. In this case 
SCIA will determine the amount of reinforcement for the ULS and use this reinforcement to calculate the actual 
stresses in the reinforcement. This value will then be compared to the defined allowable limit. The limit can be 
defined in both the design defaults and CMD. The user has three possibilities to define the limit of the stresses: 

• Auto: Based on definition in the national annexes 7.2(5). 

• Yield Strength: the limit is determined based on fyk (Characteristic yield strength of  reinforcement) 

• User input: the limit must be decided by the user.  
 

This can be checked within the output, in this case the user defined value of 150 MPa can be seen.  
 

 
 
 
As previously mentioned when the SLS restrictions are not fulfilled an increment must be calculated 
serv_coeff will be calculated depending on the following conditions: 

• In case of crack width only: servcoeff=wk,coeff= (wk / wk,max ) 0,5+0,01 
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• In case of reinforcement stress only: servcoeff=ss,coeff= (ss / ss,lim )+0,005 

• In case of reinforcement stress only: servcoeff = max(ss,coeff;wk,coeff) 
 
When the statically reinforcement is designed based on ULS +SLS, the verification of the detailing provisions 
must be done. The same procedure and warnings as used for ULS design will be applied for ULS+SLS 
design, only one step further. The final reinforcement area As_req for direction (1,2) and surface (+,-) will be 
determined by the following formula, taking into account the minimal and maximal areas from detailing 
provisions: 

As,req,1,2,± = min (max(As,ult,1,2,±; As,serv,1,2,±; As,min); As,max) 
 

 

 

 Crack control 

 
 

 INPUT DATA FOR CRACK CONTROL 
 
 

 Maximum crack width 
 
The values of the maximum crack width (wmax) are national determined parameters, dependent on the chosen 
exposure class. Therefore, this value can be found in the setup for National Determined Parameters, via the 
File menu → Project settings → National annex […] → EN 1992-1-1 […]. 
 

 
 
 

 Type of used reinforcement 
  
You can perform the Crack width check for all three types of reinforcement (Required, provided and user 
reinforcement). The crack width check is performed on a Quasi permanent SLS combination.  
If the type of reinforcement used for the crack width check is either the provided or required reinforcement an 
ULS combination should be chosen as well. This is necessary because the required/provided reinforcement is 
calculated based on an ULS combination. After this reinforcement is calculated it can be used to perform the 
crack width check. All this is done automatically and can be set in the properties window of the crack width 
check. 
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Required/provided reinforcement 
 
 
 
 

 
 

User reinforcement 
 
 
 
 

 Theoretical background 
 
 
Crack appearance 
 
If condition below is satisfied no cracks will appear in the concrete.  
 

σct,max±  ≤  fct,eff 

 
With: 

𝜎𝑐𝑡,𝑚𝑎𝑥± =  
𝑛𝑖±

𝐴𝑖,𝑖±
+  

𝑚𝑖±

𝐼𝑖,𝑖±
 . 𝑧𝑡,𝑚𝑎𝑥,𝑖± = Normal concrete stress on un-cracked section at the most tensioned 

fiber of concrete cross-section 
 

𝑓𝑐𝑡,𝑒𝑓𝑓 = The mean value of the tensile strength of the concrete effective at the time 

 
 
Calculation of crack width 
 

w =  εsm_cm . sr,max 

 
With: 
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 RESULTS FOR REQUIRED THEORITICAL REINFORCEMENT 
 

 
Desing menu → Concrete 2D → SLS crack width 
 
 
Crack width w+ 
Combination = SLS; Type of reinforcement = Required; Value = w+ 
 

 
 
 
Crack width w- 
Combination = SLS; Type of reinforcement = Required; Value = w- 
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Unity check 
Combination = SLS; Type of reinforcement = Required; Value = UC 
 

 
 
 
A green value stands for a Unity check ≤ 1 (wcalc ≤ wmax),  a grey value stands for Unity check ≤ 0,25 and a red 
value means that wmax is exceeded. 
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 Punching 

 

 

 Theoretical background 

 
 

 General 
 
 
Punching shear can result from a concentrated load or reaction acting on a relatively small area, called the 
loaded area Aload of a slab or a foundation. 
 
The most common situations where punching shear has to be considered is the region immediately 
surrounding a column in a flat ceiling plate or where column is supported on foundation plate.  
The following problem types can be distinguished: interior, edge and corner columns.  
Design of punching shear reinforcement is based on clause 6.4 of EN 1992-1-1: 2004 / A1:2014 + National 
Annexes.  
 
The verification reveals either that the load-bearing capacity of the reinforced concrete is sufficiently high, or 
that punching shear reinforcement must be designed and installed. If the verification limits are exceeded, the 
verification result is marked as not permissible. In this case, the user must change the model parameters or 
select a suitable design alternative. 
 
The verification of punching failure at the ultimate limit state can be resumed as follows: 

• Check of the shear resistance at the face of the column noted u0, and at the basic control perimeter 
named u1. 

• If shear reinforcement is required, a further perimeter uout,ef should be found where shear reinforcement 
is no longer required. 

 
Those control perimeters are shown in the following pictures: 
 

 

 
 

https://help.scia.net/webhelplatest/en/krs/attachments/theory_na_en_1992_enu.pdf
https://help.scia.net/webhelplatest/en/krs/attachments/theory_na_en_1992_enu.pdf
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 Load distribution and basic control perimeter 
 
 

 Basic control perimeter u1 
 
The basic control perimeter u1 is taken at a distance 2d from the loaded area, where d is the effective depth. 
 

 
 
 
In case the loaded area is close to an edge or a corner: 
 

 
 
 
In case there is openings near the loaded area, they are dealt with according to clause 6.4.2(3). 
If the shortest distance between the perimeter of the loaded area and the edge of the opening does not exceed 
6d (see figure), part of the control perimeter contained between two tangents drawn to the outline of the 
opening from the center of the loaded area is ineffective. 
 

 
 
 
 
In SCIA Engineer, openings inputted in the Structure menu are automatically considered according to the 
previous criteria. 
 
 

 Effective depth deff 
 
The effective depth of the slab, is assumed constant and is calculated according to formula 6.32 from EN1992-
1-1:  

deff =
(dy + dz)

2
 

 
where dy and dz are the effective depths of the reinforcement in two orthogonal directions. 
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 Punching shear calculation 

 
 
The punching shear calculation is done according to EN1992-1-1 art.6.4.3. 
 
First the design shear resistances along the control sections are calculated: 
 

• ν
Rd,c

  design value of the shear resistance of a slab without punching shear reinforcement along 

the control section considered  
• ν

Rd,cs
  design value of the punching shear resistance of a slab with punching shear reinforcement 

along the control section considered  
• ν

Rd,max
 design value of the maximum punching shear resistance along the control section considered 

 
Then the following checks should be performed. 
 
 

 Check at the column perimeter u0 
 
At the column perimeter uo, or at the perimeter of the loaded area, the maximum punching shear stress should 
not be exceeded. 

Ν
Ed0

≤ ν
Rd,max 

With : 

vEd0  design shear stress at the column perimeter u0 
vRd,max = 0.5 * v * fcd  
v  = 0.6*(1 - fck /250) 

 
 

 Check at the basic perimeter u1 
 
At the basic control perimeter u1: 

• If ν
Ed

≤ ν
Rd,c

    Punching reinforcement is not needed 

• If ν
Ed

> ν
Rd,c

    Punching reinforcement is needed 

 
The punching shear resistance of a plate VRd,c is calculated according to formula 6.47, EN1992-1-1: 

vRd,c = CRd,c. k. (100. ρl. fck)1/3 +  k1σcp ≥ (vmin + k1σcp) 

 
With: 

ρl  average reinforcement ratio in specific distance around column 
fck  characteristic concrete compressive strength in MPa 
vmin  = 0,035 ∙ k3/2 ∙ fck

1/2 
 CRd,c 

CRd,c =
0,18

γc

 

 
 k 

k = 1 + √
200

d
≤ 2,0 

 
 d in mm 
 
 
The maximum shear stress v

Ed
 is calculated for considered control perimeter ui according to clause 6.4.3(1) 

as follows: 

vEd = β.
VEd

uid
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The β-factor is to consider the non-uniform load transfer (due to unbalanced bending moment). If the load 
transfer is non-uniform, local peak loading should be compensated by help of this β-factor. 
 
In case that lateral stability of the structure does not depend on frame action between the slabs and the 
columns, and where the adjacent spans do not differ in length by more than 25%, approximate values for β 
may be used according to clause 6.4.3(6).  
 
In SCIA Engineer, the user must decide whether these approximate values can be used, because the program 
cannot check the preconditions described above. 
 
By default, the recommended approximated values are:  

          

 
 
 
Those values might be different according to the National Annexes and can be viewed in the National Annexes 
setup: 
 

 
 
 
Otherwise, as described in art 6.4.3, the β-factor can be calculated by the following general formula: 
 

β = 1 + √(ky.
MEd,y

VEd

.
u1

W1y

)

2

+ (kz.
MEd,z

VEd

.
u1

W1z

)
2

 

 
 
Calculation of β-factor with general formula can be set in Concrete setup > Punching: 
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 Design of punching reinforcement if required 
 
In case that ν

Ed
> ν

Rd,c
, punching reinforcement should be designed. 

 
If punching reinforcement is required, the outer control perimeter uout beyond which the reinforcement is no 
longer needed is calculated acc. to clause 6.4.5(4): 
 

uout,ef =
β. VEd

vRd,c. d
 

 
 
Calculation of the required punching reinforcement 
In SCIA Engineer, the shear reinforcement is designed using the following assumptions: 

− the distribution of the shear links is considered as radial only 
− only vertical shear links are supported 
− the shape of reinforcement perimeters around the column is the same as for the shape of the basic control 

perimeter 
 
The required area Asw,req of one perimeter of shear reinforcement around the column assumed as radially 
distributed vertical shear links is calculated as: 
 

 Asw,req  =
(vEd,u1  −  0.75 ∙  vRd,c) ∙  u1  ∙ sr

1.5 ∙  fywd,ef

  

 
fywd,ef  effective design strength of the punching reinforcement acc. to formula:  
fywd,ef  = 200 + 0.25 ∙ deff ≤ fywd 
 
Detailing provisions for the punching reinforcement 
The required area might be adjusted to fulfil detailing provision rules acc. to clause 9.4.3(1), so that number of 
shear links ns per each reinforcement perimeter is: 
 

ns =  max { 
4 ∙  Asw,req

π ∙  ds
2

;  
u1,last

st,max,u1

;  
us,last 

st,max,out

 } 

 
ds diameter of shear link 
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𝑢1,𝑙𝑎𝑠𝑡

𝑠𝑡,𝑚𝑎𝑥,𝑢1

   condition of maximum allowed tangential spacing of links of reinforcement perimeters placed within the 

basic control perimeter (u1,last is length of last perimeter of shear reinforcement there) 
𝑢𝑠,𝑙𝑎𝑠𝑡 

𝑠𝑡,𝑚𝑎𝑥,𝑜𝑢𝑡

   condition of maximum allowed tangential spacing of links of reinforcement perimeters placed outside 

the basic control perimeter (us,last is length of last perimeter of shear reinforcement there) 
 

 
 
In SCIA Engineer, limitation of spacing st,max,u1 and st,max,out are set in Concrete setup > Detailing provisions > 
Punching: 
 

 
 
 
The last condition, which must be fulfilled acc. to clause 9.4.3(2) is minimum reinforcement area of single shear 
link Asw1,min acc. to formula (9.11) : 

Asw1,min  =  
0,08 ∙  √fck / fywk  ∙  sr  ∙  st

1,5
 

 
With : 
 sr spacing of shear links in the radial direction 
 st spacing of shear links in the tangential direction 
 
 
The final designed area of each perimeter of shear reinforcement around the column is : 
 

Asw =
ns ∗ π ∗ ds

2

4
≥ ns ∗ Asw1,min 



Chapitre 2:  Design and Check 

MJA / TC – 2023/01/16  167 

 
The required number of shear reinforcement perimeters around columns, nper, is determined based on clause 
6.4.5(4), which specifies that the outermost perimeter of shear reinforcement, as, last = s0 + sr * nper, should be 
placed at a distance not greater than kout * deff within uout. The following formula for nper is derived : 
 

nper = [
aout − s0 − kout ∗ deff

sr

+ 1] ≥ nper,min 

 
With : 
 

Kout  Coefficient to determine the maximum distance of last perimeter from uout. Default value is 1,5. 
This is a National Annexes parameter. 

Nper,min  Minimum number of reinforcement perimeters around column required acc. to clause 9.4.3(1). 
Default value is 2 in Concrete settings > Complete setup view > Detailing provisions > 
Punching. 

Aout  Distance of the outer perimeter uout. 
 
 
The total amount of shear reinforcement Asw,tot around the column is then calculated as : 

Asw,tot = nper * Asw 
 
 

 

 Punching design 

 
 

 Configuration 
 
 
The punching check in SCIA Engineer is only available when a real column or a nodal support have been 
connected to a plate. No punching check can be performed for a point load or a little surface load applied to 
the plate. 
 
SCIA Engineer supports circular and rectangular cross sections only for the punching check. 
 
The column position with regard to the edges of the plate and the openings is recognize. Also, for the punching 
check, all edges and angles of the plate are taken as straight... so if they are not in your model, the program 
makes an approximation. 

 
SCIA Engineer doesn’t support all punching cases of column-plate connection. The list of all current limitations 
can be found in our webhelp. Each unsupported configuration is mentioned in the list of Errors/warning/notes 
of the report in the punching check report. 
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 Choice of reinforcement 
 
 
The punching design will check if the longitudinal reinforcement As in the plate is sufficient to resist to the 
shear force around a column-plate or nodal support-plate connection. 
 
In SCIA Engineer the user can choose between 3 types of reinforcement for the punching check/design: 

• As, required – calculated by the software for a specific load combination 

• As,provided – user set in Reinforcement design > Design defaults 

• As,user - practical reinforcement inputted by user manually in 2D Reinforcement 
 
The choice between As,required, As,provided or As,user is done in the Properties window for Punching design: 
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 Punching check 
 
 
Studied example: punching.esa 
 
Geometry: 
Concrete class C30/37 
Reinforcement class B500B 
Plate thickness 200 mm 
Column cross-section 10 x R 300x300 mm²  and 6 x circular C400 mm²   
 
Plate and columns are connected to each other by means of the action Connect members/nodes. 
 
Loading: 
*Load cases 
SW: Self weight 
DL: Dead Load = Surface load -1 kN/m2 + Line force on edges -1 kN/m 
LL: Live Load = Surface load -1 kN/m² 
LL1: Additional case for further study= -25 kN/m², to be explained later 
 
*Combinations 
ULS (Type EN – ULS (STR/GEO Set B)) = SW, DL, LL 
SLS (Type EN – SLS Quasi Permanent) = SW, DL, LL 
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Work method 
The Punching Design command can be selected in the main menu “Design”: 
 

 
 
 
The command is available, when EC - EN national code is selected in Project data and the linear or non-linear 
static analysis is done for the model containing 2D members from concrete material. Once the command is 
selected, appropriate parameters are listed and can be adjusted in property window with following options: 
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• Set the type of Selection to ALL, the Type of load to Combination ULS and the type of 
Reinforcement to Required then click “Refresh”  

 
You will notice that the UC for every node will be displayed along with the control parameter in 
colour. In total there are 3 colours (Green, blue and red).  

 
▪ Green: Shear capacity without reinforcement is sufficient (UCvRd,c ≤ 1.0 and 

UCvRd,max ≤ 1.0)  
▪ Blue: Shear capacity with shear reinforcement is sufficient (UCvRd,c > 1.0 but 

UCvRd,cs ≤ 1.0)  
▪ Red: Plate is not designable by application of reinforcement or maximum shear 

capacity of concrete adjacent to the column is not sufficient (UCvRd,cs > 1.0 or 
UCvRd,max > 1.0)  
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• Presentation of results as a numerical output is possible via Preview and / or Table results. For 
the Punching Design, there is available two types of output: 

 
- Brief - contains just a summary table with basic results 

 

 
 
 

- Standard - contains the same summary table as in Brief output supplemented by 
additional tables providing further semi-results 
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 Shear capacity without reinforcement is sufficient 
 
Select Node N61 and change the type of selection to current. 
A brief output will show:  
 

 
 
We can see that the UC < 1, let’s look at the standard output for this node:  
 

 
 
 
We can see that VEd,u1 = 0,28MPa < VRd,c = 0,55MPa so the shear capacity without reinforcement is sufficient. 
The control parameter is displayed in Green colour.  
 
 

 Shear capacity with reinforcement is sufficient 
 
Let us look now at the standard output for node N59:  
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We can see here that VEd,u1 = 0,58MPa < VRd,c= 0,55MPa and the UCvRd,c = 1,06 > 1. 
So shear reinforcement needs to be designed. The final value is Asw,tot = 1810mm2 which take into account 
detailing provisions.  
The control parameter is displayed in blue colour.  
 
You can also show the Asw,tot graphically:  
 

 
 
 
 
 

 Use of provided reinforcement 
 
Let’s add some provided reinforcement to the plate.  
In the Concrete settings, go to the Design Defaults view :  
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Activate the provided template for the plates : 
 

 
 
 
Here you can choose between the different templates.  
You can give a basic provided reinforcement without any additional reinforcement or allow SCIA Engineer to 
calculate additional reinforcement when needed. 
For this example, we will define the basic reinforcement without additional reinforcement and we will use 
diameter 16mm with a spacing of 150mm.  
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Now look at the standard output for node N59. With the required reinforced we needed additional shear 
reinforcement but with the provided reinforcement set above no need for shear reinforcement:  
 

 
 
 
We can see that VEd,u1 = 0,58 MPa < VRd,c = 0,71 MPa so the shear capacity without reinforcement is sufficient. 
The control parameter is now displayed in Green colour instead of blue.  
 
 
 

 Unity check is not ok: control perimeter is red 
 
Change the “Type of Result” to Load Case LL1 and display the result for node N59: 
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Control perimeter is now displayed in red and the UC = 1,44 > 1. 
 
Take a look at the Standard Output:  
 

 
 
 
We can also show the errors and warning in the output by checking this option in the properties window:  
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 Code dependant deflection (CDD) 

 

 

 Intro 

 
 
The CDD calculation is a more rigorous calculation of the deflection. The calculation procedure is the same as 
for the simplified method, but with following differences: 

• 3 types of combinations are used to calculate the deflections 

• Calculation of stiffness is more precise 
  
 
To be able to use this method in SCIA Engineer, the following settings should be set beforehand: 

1. Use the post processing environment ‘default’ in the Project menu: 
 

 
 
 

2. In the Concrete menu, you will then see a new check named Code dependent deflection: 
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 Types of combination for CDD 

 
The combinations used for the CDD calculation can either be automatically generated or inserted but the user. 

Automatic Creation of combinations for CDD 

Three different combinations are automatically created by the software in the background to calculate the 
deflection: 

1. Combination for calculation of total deflection 
Generated directly from the user choice of combination in the CDD check, properties window: 

 

 
 

2. Combination for calculation of immediate deflection 
Uses the generated combination for total deflection and removes variable load cases with 
duration type Medium, Short or Instantaneous. 
Duration type is defined in the Load cases properties: 
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3. Combination for calculation of deflection due to creep 
Uses the generated combination for total deflection and multiplies variable load cases by a 
coefficient defined in Concrete settings > Deflections: 

 

 
 
 
Additional characteristic combinations are generated for each previously mentioned combination to determine 
if the section is cracked or uncracked. 
 

Manual input of combinations for CDD  

It is possible for the user to introduce his own combinations for calculation of immediate deflection and 

deflection due to creep. 

 

In order to introduce these manual combinations, the option “Automatic combination” must be unchecked in 
the CDD check, properties window. 

Two new sections (“Result case: Creep deflection” and “Result case: Immediate deflection”) appear in the 
properties window where you can choose the combinations for creep and immediate deflections. 

These combinations have to be linear combinations, it means that creep and immediate deflection will be the 
same for all sub-combinations generated from combination for total deflection. 
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The combination for calculation of total deflection remains generated directly from the user choice of 
combination in the CDD check, properties window. 

 

 Type of reinforcement 

 
For the CDD method, it is possible to calculate the deflection with required, provided or user inputted 
reinforcement. This choice is done in the Properties window of the CDD check: 
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 Calculation of stiffness for 1D elements 

 
Members which are not expected to be loaded above the level which would cause the tensile strength of the 
concrete to be exceeded anywhere within the member should be considered to be uncracked. Members which 
are expected to crack, but may not be fully cracked, will behave in a manner intermediate between the 
uncracked and fully cracked conditions. New stiffness (stiffness with taking into account cracking) is calculated 
in center of each 1D element. 
 
Two types of stiffness are calculated: 
 
Short-term stiffness - is calculated using 28 days modulus of elasticity Ec = Ecm, it follows that value of 
stiffness is loaded directly from properties of the concrete material 
Long-term stiffness - is calculated using effective E modulus based on creep coefficient for acting load, it 

follows Ec = Ec,eff = Ecm/(1+). 
 

Calculation effective modulus of elasticity is based on equation 5.27 in EN 1992-1-1, but instead of effective 

creep coefficient ef, only creep coefficient  is used 

 
The following procedure is used for the calculation of stiffnesses: 

1) The transformed cross-section characteristics of uncracked section (Ai, Ii, ti...) are calculated 
2) The stiffnesses of the uncracked cross-section ((Eiy)I,( Eiz)I, (EA)I) to the center of the uncracked 

transformed cross-section are calculated. 

3) The maximum value of tensile stress of the uncracked cross-section (value ct,res) for respective 
characteristic combination (Nchar,res,Mchar,res,y, Mchar,res,z) is calculated 

4) The maximum value of tensile stress of uncracked cross-section (value ct,imm) for immediate 
characteristic combination (Nchar,im,Mchar,im,y, Mchar,im,z) is calculated 

5) Compare ct with ct,imm 

If ct≥ct,imm 
The respective characteristic combination will be used for calculation, Nchar=Nchar,res,Mchar,y =Mchar,res,y, 

Mchar,z=Mchar,res,z,ct=ct,res 

If ct≤ct,imm 
The immediate characteristic combination will be used Nchar=Nchar,im,Mchar,y =Mchar,im,y, Mchar,z=Mcharim,z,ct=ct,im 

6) Compare ct with cr 

If  ct≤cr 
Cross-section is uncracked: 
▪ bending stiffness around y-axis EIy = (Eiy)I 
▪ bending stiffness around z axis EIz = (Eiy)I 
▪ axial stiffness EA = EAI, 

If ct≥cr 
Cross-section is cracked and average stiffness will be calculated. 
(Calculation of average stiffness) 

7) The transformed Css characteristics of the cracked section (Air, Iir, tir...) is calculated. 
8) The stiffnesses of the fully cracked cross-section ((Eiy)II,( Eiz)II, (EA)II) to center of cracked transformed 

cross-section is calculated 

9) The stress in the tensile reinforcement of the fully cracked cross-section (value sr) for characteristic 
combination (Nchar,Mchar, Mchar,z) is calculated. 

10) The stress in the tensile reinforcement of the fully cracked cross-section (value s)for respective 
combination (N,My,Mz) is calculated. 

11) The distribution coefficient according equation 7.19 in EN 1992-1-1 is calculated 

 
where  is a coefficient taking account the influence of the duration of the loading or of repeated loading on 

the average strain (=1 for calculation of short-term stiffness, =0,5 for calculation of long-term stiffness) 
 
 
 



Advanced Concept Training – Concrete 

184  MJA / TC – 2023/01/16 

12) The average value of the stiffnesses based on equation 7.18 in EN 1992-1-1 is calculated 

o bending stiffness around y-axis (Eiy) = 1/[/(Eiy)II + (1-)/ (Eiy)I] 

o bending stiffness around z-axis (Eiz) = 1/[/(Eiz)II + (1-)/ (Eiz)I] 

o axial stiffness (EA) = 1/[(/(EA)II + (1-)/( EA)I], 
 

Stiffness is recalculated to principal axis for unsymmetrical cross-section 

 
13) The five types of stiffnesses are calculated for each 1D element and each dangerous combination: 

Type of stiffness Respective combination 

Short-term stiffness for immediate deflection Immediate 

Short-term stiffness for short-term deflection Total 

Short-term stiffness for creep deflection Creep 

Long-term stiffness for creep deflection Creep 

Long-term stiffness for shrinkage deflection Total 

 
14) The following stiffnesses are changes in stiffness matrix for 1D elements: 

EAx =EA 

GAy=GAz = GEAx/(1.2Ec) 
EIy =Eiy 
EIz =Eiz 

GIx=0.5(1-)(EIy)EIz)0.5 

 
where 

G is shear modulus of the concrete calculated according to formula G = 0.5Ec/(1+) 

 is Poisson coefficient of the concrete loaded from material properties of the concrete 
 

Eccentricity of stiffnesses (distance between center of gravity of concrete cross-section and center of gravity 
of cracked transformed cross-section) is not taken into account in current version 

Calculation of curvature, strain and stiffness caused by shrinkage of a 1D element 

Calculation of shrinkage forces 

The forces caused by shrinkage are calculated according to formulas below. The forces are calculated for both 
states: uncracked and cracked cross-section. 

Nshr = -cs(t,ts)·CoefReinf(Esi·Asi) 
Mshr,y = Nshr·eshr,z 
Mshr,z = Nshr·eshr,y 

 
Where 

eshr,y =(Esi·Asi)/ (Esi·Asi·ysi) - tiy 

eshr,z =(Esi·Asi)/ (Esi·Asi·zsi) - tiz 

cs(t,ts)· - total shrinkage strain 
Coefreinf - coefficient increasing amount of reinforcement 
Esi - modulus of elasticity of i-th bar of reinforcement 
Asi - area of reinforcement of i-th bar of reinforcement 
ysi - position of i-th bar of reinforcement from center of gravity of cross-section in y-direction 
zsi - position of i-th bar of reinforcement from center of gravity of cross-section in z-direction 
tiy - distance between center of gravity of transformed uncracked/cracked cross-section and center of gravity 
of concrete cross-section in y-direction 
tiz - distance between center of gravity of transformed uncracked/cracked cross-section and center of gravity 
of concrete cross-section in z-direction 
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Calculation of strain and curvature caused by the shrinkage 

Strain and curvature caused by shrinkage are calculated for each 1D element and these values are calculated 
for both states (uncracked and cracked cross-section) 
 
Calculation of strain caused by shrinkage: 

x =-cs(t,ts)·CoefReinf·(Esi·Asi)/(Eceff·Ai) 
 
Calculation of curvature around y and z axis caused by shrinkage 

(1/ry) = -cs(t,ts)·CoefReinf·(Esi·Asi·(tiz-zsi))/(Eceff·Iiy) 

(1/rz) = -cs(t,ts)·CoefReinf·(Esi·Asi·(tiy-ysi))/(Eceff·Iiz) 
  
Where 

cs(t,ts)· - total shrinkage strain 
Coefreinf -  coefficient increasing amount of reinforcement 
Esi - is modulus of elasticity of i-th bar of reinforcement 
Asi - is area of reinforcement of i-th bar of reinforcement 
ysi - position of i-th bar of reinforcement from center of gravity of cross-section in y-direction 
zsi - position of i-th bar of reinforcement from center of gravity of cross-section in z-direction 
tiy - distance between the center of gravity of transformed uncracked/cracked cross-section and center of 
gravity of concrete cross-section in y-direction 
tiz - distance between the center of gravity of transformed uncracked/cracked cross-section and center of 
gravity of concrete cross-section in z-direction 

Eceff - effective modulus of elasticity of the concrete calculated according to formula Ec = Ec,eff = Ecm/(1+). 
Ecm - secant modulus of elasticity of concrete 

 - creep coefficient 
Ai - transformed area of uncracked/cracked cross-section 
Iiy - transformed second moment of area around y-axis of uncracked/cracked cross-section calculated to center 
of gravity of transformed uncracked/cracked cross-section 
Iiz - transformed second moment of area around z axis of uncracked/cracked cross-section calculated to center 
of gravity of transformed uncracked/cracked cross-section 
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Calculation of stiffnesses for shrinkage 

The stiffness of uncracked/cracked cross-section for shrinkage is calculated from strain and curvatures caused 
by shrinkage by using total level of load (total load combination) 

• bending stiffness around y-axis EIy =Mtot,y/(1/ry) 

• bending stiffness around z axis EIz = Mtot,z/(1/rz) 

• axial stiffness EA = Ntot/x 

 

 Calculation of stiffness for 2D elements 

 
The following procedure is used for the calculation of stiffness of 2D elements: 
 

1) The principal stresses of 2D element for both surfaces is calculated 

 
2) The angle of principal stresses at both surfaces is calculated 

 
3) The final value of the principal stress is calculated 

=+ if 1+≥1- 

=− otherwise 

4) The internal forces are recalculated to the direction of the principal stresses  

 
where nx,ny,nxy,mx,my,mxy are 2D forces in center of 2D element 

5) The area of reinforcement is recalculated to the direction of of the principal stress  

As() = Ascos2(-s) 

where As,s is area and angle of longitudinal reinforcement 
6) The non-linear stiffness in the first principal direction is calculated according to the procedure as for 

1D element 
o for rectangular cross-section (b =1m, h = thickness of 2D element in center of gravity) 

o for internal forces N = n() , My= m() and Mz=0 according procedure as for 1D 
element 

7) The non-linear stiffness in the second principal direction is calculated according to the procedure as 
for 1D element 

o for rectangular cross-section (b =1m, h = thickness of 2D element in center of gravity) 

o for internal forces N = n(+) , My= m(+) and Mz=0 according procedure as for 
1D element 

8) The stiffness for shrinkage deflection is calculated in both directions of principal axes as explained in 
the next section. 

9) The five types of stiffnesses are calculated for each 2D element and each dangerous combination: 

 

 

 

https://help.scia.net/webhelplatest/en/val/concrete15/codedependentdeflection/images/cdd_tb_principal_stress.png
https://help.scia.net/webhelplatest/en/val/concrete15/codedependentdeflection/images/cdd_tb_principal_angle.png
https://help.scia.net/webhelplatest/en/val/concrete15/codedependentdeflection/images/cdd_tb_principal_force.png
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Type of stiffness Respective combination Direction of principal stress 

Short-term stiffness for immediate deflection Immediate 

First (EA1,EIy1,EIz1) 

Second (EA2,EIy2,EIz2) 

Short-term stiffness for short-term deflection Total 

First (EA1,EIy1,EIz1) 

Second (EA2,EIy2,EIz2) 

Short-term stiffness for creep deflection Creep 

First (EA1,EIy1,EIz1) 

Second (EA2,EIy2,EIz2) 

Long-term stiffness for creep deflection Creep 

First (EA1,EIy1,EIz1) 

Second (EA2,EIy2,EIz2) 

Long-term stiffness for shrinkage deflection Total 

First (EA1,EIy1,EIz1) 

Second (EA2,EIy2,EIz2) 

 

10) The following stiffnesses are changes in stiffness matrix for 2D elements: 
D11 = EIy1 
D22 = EIy2 

D33 = 0.5(1-)(D11D22)0.5 

D44 = Gh/1.2 

D55 = Gh/1.2 

D12 =  (D11D22)0.5 
d11 = EA1 
d22 = EA2 

d33 = Gh 

d12 =  (d11d22)0.5 

G is shear modulus of the concrete calculated according to formula G = 0.5Ec/(1+) 

 is Poisson coefficient of the concrete loaded from material properties of the concrete 
 

Eccentricity of stiffnesses (distance between center of gravity of concrete cross-section and center of gravity 
of cracked transformed cross-section) is not taken into account in current version 

 

Calculation of curvature, strain and stiffness caused by shrinkage of a 2D element 

Calculation of shrinkage forces 

The forces are calculated in the center of gravity of each element and they are calculated in two directions: 

• The first one is the direction of principal stress  

• The second one is the direction of principal stress +90° 
 

The forces caused by shrinkage for first/second direction are calculated according to formulas below. The 
forces are calculated for both states: uncracked and cracked cross-section. 

nshr = -cs(t,ts)·CoefReinf(Esi·Asi()) 
mshr = nshr·eshr,z 

 
where 

eshr,z =(Esi·Asi())/ (Esi·Asi()·zsi) - tiz() 

cs(t,ts) - total shrinkage strain 
Coefreinf - coefficient increasing amount of reinforcement 
Esi - is modulus of elasticity of i-th bar of reinforcement 
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Asi() - is area of reinforcement of i-th bar of reinforcement in first (angle )/second direction (angle +90°) of 
principal stress 
zsi - position of i-th bar of reinforcement from center of gravity of cross-section in z-direction 

tiz() - distance between center of gravity of transformed uncracked/cracked cross-section and centre of gravity 

of concrete cross-section in z-direction and in first (angle )/second direction (angle +90°) of principal stress 
  

Calculation of strain and curvature caused by the shrinkage 

Strain and curvature caused by shrinkage are calculated for each 2D elements and these values are calculated 
for both states (uncracked and cracked cross-section). The values are calculated in both directions of principal 
stresses. 
 
Calculation of strain caused by shrinkage: 

x =-cs(t,ts)·CoefReinf·(Esi·Asi())/(Eceff·Ai()) 
 
Calculation of curvature around y and z axis caused by shrinkage: 

(1/r) = -cs(t,ts)·CoefReinf·(Esi·Asi()·(tiz()-zsi))/(Eceff·Iiy()) 
  
where 

cs(t,ts) - total shrinkage strain 
Coefreinf - coefficient increasing amount of reinforcement 
Esi - is modulus of elasticity of i-th bar of reinforcement 

Asi() - is area of reinforcement of i-th bar of reinforcement in first (angle )/second direction (angle +90°) of 
principal stress 
zsi - position of i-th bar of reinforcement from center of gravity of cross-section in z-direction 

tiz() - distance between centre of gravity of transformed uncracked/cracked cross-section and centre of gravity 

of concrete cross-section in z-direction and in first (angle )/second direction (angle +90°)of principal stress 

Eceff - effective modulus of elasticity of the concrete calculated according formula Ec = Ec,eff = Ecm/(1+). 
Ecm - secant modulus of elasticity of concrete 

 - creep coefficient 

Ai() - transformed area of uncracked/cracked cross-section in the first (angle )/second direction 

(angle +90°) of principal stress 

Iiy() - transformed second moment of area around y axis of uncracked/cracked cross-section calculated to 

centre of gravity transformed uncracked/cracked cross-section in the first (angle )/second direction 

(angle +90°)of principal stress 
  

Calculation of stiffnesses for shrinkage 

The stiffness of uncracked/cracked cross-section for shrinkage is calculated from strain and curvatures caused 
by shrinkage by using total level of load (total load combination) 

• bending stiffness in direction of first principal axis EIy1 =mtot()/(1/r)1 

• bending stiffness in direction of second principal axsi EIy2 =mtot(+)/(1/r)2 

• axial stiffness in direction of first principal axis EA1 = ntot()/x,1 

• axial stiffness in direction of second principal axis EA2 = ntot(+)/x,2 
 

where 

ntot(), ntot(+ - are axial forces from total combination in 2D element recalculated to direction of first and second 
principal axis 

mtot(), mtot(+ - are bending moments from total combination in 2D element recalculated to direction of first 
and second principal axis 

x,1(2) - is strain caused by shrinkage calculated in direction of first (second) principal axis 
(1/r)1(2) - is curvature caused by shrinkage calculated in direction of first (second) principal axis 
 

Deflection for shrinkage is calculated in FEM analysis for total combination, therefore the stiffness are 
calculated with using internal forces for total combination  



Chapitre 2:  Design and Check 

MJA / TC – 2023/01/16  189 

 Parameters for the calculation of shrinkage strain 

 
The total shrinkage strain is composed of two components, the drying shrinkage strain and the autogenous 
shrinkage strain. The drying shrinkage strain develops slowly, since it is a function of the migration of the water 
through the hardened concrete. The autogenous shrinkage strain develops during hardening of the concrete. 

There are three options for calculation/input of total shrinkage strain that can be selected in the concrete 
settings menu: 

• No (Consider drying and autogenous shrinkage= No): shrinkage will not be taken into account in 
CDD calculation 

• Automatic calculation (Consider drying and autogenous shrinkage = Auto), where shrinkage 
strain is calculated according to EN 1992-1-1, chapter 3.1.4(6) for following input parameters: 

o Relative humidity 

o Age of concrete at beginning of drying shrinkage 

o Age of concrete at moment considered 

 

Except of these input parameters, automatic calculation of shrinkage strain depends on material 
properties (mean compressive strength of concrete fcm, characteristic compressive cylinder strength 
fck, type of cement), cross-section parameters (cross-sectional area Ac and the perimeter of the 
member in contact with the atmosphere u) 

• User input (Consider drying and autogenous shrinkage = User value) and user can input directly 
value of total shrinkage strain 
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 Calculation of deflection 

 
The following deflections are calculated in the CDD check: 
 
δlin linear (elastic) deflection, calculated for the total combination and for linear stiffness.  
 
Δimm immediate deflection, the deflection after applying permanent and long-term variable loads which means 
calculated for short-term stiffness and immediate combination 
 
δshort short-term deflection, the deflection which considers cracking of cross-section calculated for short-term 
stiffness and total combination 
 
δcreep creep deflection, calculated as the difference between deflection calculated for long-term and short-term 
stiffness for the creep combination. Δcreep = δcreep, long – δcreep, short 

 

δshr deflection caused by drying and autogenous shrinkage. The long-term stiffness is calculated from strain 
and curvature caused by shrinkage using total combination. 
 
δadd additional deflection, the deflection after applying a variable load and considering creep calculated as the 
difference between total and immediate deflection. Δadd = δtot – δimm 

 
δtot total deflection, the deflection which considers creep and cracking calculated as the sum of short-term 
deflection and deflection caused by creep. Δtot = δshort + δcreep 
 

 
 
All those values can be displayed on the screen: 
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Chapitre 3:  Modification of results 

 

 

 

 Location 

 
 
During a calculation in SCIA Engineer, the node deformations and the reactions are calculated exactly (by 
means of the displacement method). The stresses and internal forces are derived from these magnitudes by 
means of the assumed basic functions, and are therefore in the Finite Elements Method always less accurate.  
 
The Finite Elements Mesh in SCIA Engineer exists of linear 3- and/or 4-angular elements. Per mesh element 
3 or 4 results are calculated, one in each node. When asking the results on 2D members, the option ‘Location’ 
in the Properties window gives the possibility to display these results in 4 ways. 
 
 
 
 

 In nodes, no average 

 

All of the values of the results are taken into account, there is no averaging. In each node are therefore the 4 
values of the adjacent mesh elements shown. If these 4 results differ a lot from each other, it is an indication 
that the chosen mesh size is too large. 
This display of results therefore gives a good idea of the discretisation error in the calculation model.  
 

    
 

 

 

 

 In centers 

 
 
Per finite element, the mean value of the results in the nodes of that element is calculated. Since there is only 
1 result per element, the display of isobands becomes a mosaic. The course over a section is a curve with a 
constant step per mesh element.  
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 In nodes, average 

 
The values of the results of adjacent finite elements are averaged in the common node. Because of this, the 
graphical display is a smooth course of isobands. 
 
In certain cases, it is not permissible to average the values of the results in the common node: 
- At the transition between 2D members (plates, walls, shells) with different local axes. 
- If a result is really discontinuous, like the shear force at the place of a line support in a plate. The peaks will 
disappear completely by the averaging of positive and negative shear forces. 
 

   
 
 
 
 

 

 In nodes, average on macro 

 
The values of the results are averaged per node only over mesh elements which belong to the same 2D 
member and which have the same directions of their local axes. This resolves the problems mentioned at the 
option ‘In nodes, average’.  
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 Accuracy of the results 

 
 
If the results according to the 4 locations differ a lot, then the results are inaccurate and the mesh has to be 
refined. A basic rule for a good size of the mesh elements, is to take 1 to 2 times the thickness of the plate. 
 
 
 
 

 Averaging strip 

 
 
An averaging strip averages peak values over a zone. You can find the averaging strip in the Input Panel in 
the  “Result tools” category : 
 

 
 

 
 
 
Type: a point or a strip can be chosen. 
Dimensions: here the dimensions of the point/strip need be set. 
Direction:  
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1) Direction = Longitudinal 
 

 
 
 
Longitudinal means that the averaging is done in the longitudinal direction of the strip. In the example above 
this is the y-direction. This means that the averaging is done for my. The values my are averaged in the x-
direction. 
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2) Direction = perpendicular 
 

 
 
Perpendicular means that the averaging is done perpendicular to the longitudinal direction of the strip. In the 
example above this is the x-direction. This means that the averaging is done for mx. The values mx are 
averaged in the y-direction. 
 
 

3) Direction = Both 
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Both means that the averaging is done in both directions of the averaging strip. This means the values are 
averaged for mx as well as my in the direction perpendicular to mx and my. 
 
To activate the averaging strip, the option ‘Averaging of peak’ needs to be checked in the properties window. 
 

 
 
 
 
As an example, we will apply averaging strips to the model of the chapter “2D concrete members” for the value 
Asw,req. 
 
 

Asw,req without Averaging of peaks 
 

 
 
 

 
 
Asw,req with averaging of peaks 
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 Rib 

 
 
A rib can be added to a plate in the Input Panel in the  “1D Members” category : 
 

 
 
 
But also in the Input Panel in the  “2D Members” category : 
 

 
 
 
 

 Results in ribs 

 
When a rib is added to the model there will be an option rib available in the result properties of 1D and 2D 
members. This option has an influence on what results you view. 
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 RIB Activated RIB Not Activated 

1D-Results 

  

2D-Results 

 

 

 

 

 
 Link between the internal forces calculated for the entire T-section, and for the beam and slab 

separately 
 
 
When calculating the internal forces in a rib, the substitute T-section is used to calculate the results. The web 
of this T-section is formed by the rib-beam itself, the flange of the T-section is made with the effective width of 
the slab. The effective width of the slab has to be used to determine the internal forces of the slab that have 
to be added to the internal forces calculated in the rib itself. 
 

 
 
 
The coordinates of the hearts are used as lever arms in Y and Z direction: 
 

https://www.scia.net/sites/default/files/faq_how_are_the_internal_forces_calculated_in_the_ribs_influence_of_effective_width_-_ibm_lotus_notes.jpg
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The final internal forces in the rib can be calculated with the formula below: 
 
N = N beam + N slab, left + N slab, right 
Vy = Vy beam + Vy slab, left + Vy slab, right 
Vz = Vz beam + Vz slab, left + Vz slab, right 
Mx = Mx beam + Mx slab, left + Mx slab, right 
My = My beam + My slab, left + My slab right + N slab, left * (Lever Arm Z1) – N slab, right * (Lever Arm Z2) + N 
beam * Lever Arm Z3; 
Mz = Mz beam + Mz slab, left + Mz slab, right + N slab, left * (Lever Arm Y1) – N slab, right * (Lever Arm Y2) + 
N beam * Lever Arm Y3; 
 
 
 

 Why is there an axial force in the rib ? 
 
 
SCIA Engineer integrates the ribs as eccentric beams attached to slabs. The eccentricity is calculated from 
the half of the slab thickness and half of the height of the cross section of the beam. 
 

 
 
 
During the input of the cross section of the beam, the height of the cross section is defined as a distance 
between the bottom of the slab and the bottom of the beam. In the picture, the height is marked as “H”. 
 
Due to the shift of the neutral axis, the internal forces in the whole system change. In a simple system subject 
to a bending moment only, we get a structure with an internal bending moment as well as axial force. 
 
Usually, if the beam is below the slab, we get compression in the slab and tension in the beam. 
The eccentric beam causes axial forces in the slab. This results from the deformation of the whole slab+beam 
system. The picture shows the horizontal deformation “ux” to explain graphically the behaviour of the system. 
This system is composed of two beams of a rectangular cross section connected by rigid links. The horizontal 
displacement of the support is free to prevent the constraint. 
 
 

https://www.scia.net/sites/default/files/faq_how_are_the_internal_forces_calculated_in_the_ribs_influence_of_effective_width_-_ibm_lotus_notes_3.jpg
https://www.scia.net/sites/default/files/tip-se-22016-1.jpg
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The horizontal deformation in a side view: 
 

 
 
 
If we look at the beginning of the beam, we can see compression in the slab and tension in the beam: 
 

https://www.scia.net/sites/default/files/tip-se-22016-2.jpg
https://www.scia.net/sites/default/files/tip-se-22016-3.jpg
https://www.scia.net/sites/default/files/tip-se-22016-4.jpg
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Of course, the whole system must be in equilibrium and the total axial force equal to the sum of the axial force 
in the slab and in the beam must be zero. 
 

 

 
 
 
In our model, we have only one beam and all the internal forces of the top part are integrated in the axial force 
in the rib. Practically, the effective width of the slab is smaller than the whole width of the slab. Only 
exceptionally are the ribs arranged in such a way that there are no gaps in between the effective widths and 
all internal forces in the slab can be summed up into the rib. This happens if the distance between the ribs is 
smaller or equal to the effective width of the slab calculated from the national code. 
 
 
 

 Behaviour of a rib in a wide slab 
 
 
Now we can investigate a system where the width of the slab is greater than the effective width of the slab. 
The equilibrium condition must be fulfilled. If we integrate all the axial forces in the whole slab and the beam, 
we - of course - get a zero result. 

 
Distribution of the axial force in the slab. This is independent on the defined effective width of the slab. Only 
the stiffness of the slab and beam is responsible for the shape of the distribution of internal forces. 

 

https://www.scia.net/sites/default/files/tip-se-22016-5.jpg
https://www.scia.net/sites/default/files/tip-se-22016-6.jpg
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This is a section across the middle of the slab showing the distribution of the axial force.  
 

 
 
 
We can integrate the axial force in the section across the whole width of the slab. We get 439kN.  
 

 
 
 
Compared to the axial force in the beam, which is 435kN. We see the whole system is in equilibrium. The small 
difference results from the size of the finite elements. 
 

https://www.scia.net/sites/default/files/tip-se-22016-7.jpg
https://www.scia.net/sites/default/files/tip-se-22016-8.jpg
https://www.scia.net/sites/default/files/tip-se-22016-9.jpg
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 Comparison of different effective widths 
 
 
However, if we extend the effective width of the slab to the whole width of the slab, we neglect the distribution 
of the internal forces over the slab and the concentration over the beam. (In fact, there are two limit values: 
the minimum effective width is equal to the width of the beam and the maximum one is equal to the whole 
width of the slab.) 
 
The internal forces in the slab are excluded from the slab and integrated into a new virtual T section. This 
virtual section consists of the effective slab width and the beam. 
 
Distribution of the axial force in the slab. We can see that the distribution is equal to the one in the pictures 
above where the effective width of the slab was defined according to the code.  
 

 
 
 
 
 
In the picture we can see the axial force after the forces within the effective width of the slab were excluded 
from the slab. In SCIA Engineer you can achieve this using the checkbox “RIB” in the results.  
 

https://www.scia.net/sites/default/files/tip-se-22016-10.jpg
https://www.scia.net/sites/default/files/tip-se-22016-11.jpg


Advanced Concept Training – Concrete 

204  MJA / TC – 2023/01/16 

 
 
 
 
These axial forces within the effective width of the slab can be integrated.  
 

 
 
 
We get axial force equal to 56kN, which is in the slab. The total axial force in the slab was 435kN. Therefore, 
in the part outside the effective width we have axial force 435 - 56 = 379kN.  
 

 
 
 
 
 
In the beam, we still have the same 445kN. (The difference to the previous pictures results from the changed 
size of the 2D finite elements). 
 

https://www.scia.net/sites/default/files/tip-se-22016-12.jpg
https://www.scia.net/sites/default/files/tip-se-22016-13.jpg
https://www.scia.net/sites/default/files/tip-se-22016-14.jpg
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If we create the sum of the integrated axial force in the slab and in the beam, we must get 445 – 57 = 388kN. 
 

 
 
 
Look what happens if we increase the effective width of the slab to 1500mm. This results from the following 
formula: 2 * (0,1 * L) + bw = 2*0,6+0,3 
 

 
 
 
As we can see, the axial force in the slab is still the same. It must be, because the effective width of the slab 
has no influence on the distribution of the axial force in the finite element calculation. It only affects the split of 
the forces after the calculation between the slab and the virtual T section. 
The area of the effective width of the slab will be removed from the slab and the forces will be integrated into 
the T section. The internal forces outside of the slab will remain in the slab.  
 

 
 

https://www.scia.net/sites/default/files/tip-se-22016-15.jpg
https://www.scia.net/sites/default/files/tip-se-22016-16.jpg
https://www.scia.net/sites/default/files/tip-se-22016-17.jpg
https://www.scia.net/sites/default/files/tip-se-22016-18.jpg
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These internal forces will be moved to the T section. 
 

 
 
If we integrate the axial forces, we get 234kN. 
 

 
 
 
In the rectangular section below the slab we get the original 445kN.  
 

 
 
 
If we reduce this axial force of the beam by 234kN, which is the sum of the axial forces from the effective width 
of the slab, we get 211kN 
 

.  
 
 
The axial force outside the effective width remains in the slab. 
 

https://www.scia.net/sites/default/files/tip-se-22016-19.jpg
https://www.scia.net/sites/default/files/tip-se-22016-20.jpg
https://www.scia.net/sites/default/files/tip-se-22016-21.jpg
https://www.scia.net/sites/default/files/tip-se-22016-22.jpg
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If we integrate the forces (left and right) outside the effective width, we get axial force equal to 210kN, which 
is in equilibrium with the tension in the rib as a T Section. 
 

 
 
 
 

 

 Stiffness of ribs in CDD calculation 

 
The calculation of the stiffness of the rib depends on the checkbox “Rib”.  
 
 

 Check box is OFF 
 
The stiffness of the beam and the plate will be calculated separately. If there is 1D reinforcement in part of the 
slab it is not taken into account for the calculation of the stiffness of the plate. 
 
 

 Check box is ON 
 
1) Equilibrium for the final cross-section is calculated for each dangerous combination and each type of 

stiffness.  
 
2) The stiffness of the rib, only taking into account the rib cross-section, is calculated with the height of 

compression zone from equilibrium on the whole (final) section. Stiffnesses are calculated to the centre of 
gravity of the transformed final cross-section. 

 

https://www.scia.net/sites/default/files/tip-se-22016-23.jpg
https://www.scia.net/sites/default/files/tip-se-22016-24.jpg
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3) Stiffness of the 2D element outside of the effective width is calculated by the standard procedure. Stiffness 

of the 2D element inside effective width is calculated in two directions: direction of the rib (rib)and direction 

perpendicular to the rib. (rib + 90) 
 
4) The stiffness perpendicular to the rib is calculated by the standard procedure. 
 
5) The stiffness in the direction of the rib is calculated according to following procedure: 
 

• The 1D reinforcement which is designed or inputted in part of the slab of the final cross-section is 
taken into account for the calculation of the stiffness of the 2D element. This reinforcement is 
transformed to 2D reinforcement and is added to the standard 2D reinforcement. 

 

• Uncracked stiffnesses (EAI, EIy,I, EIz,I) will be calculated for the whole thickness of the 2D element 
with standard 2D reinforcement (required/provided/user) and with transformed reinforcement from 
the 1D member. The stiffness is calculated to the transformed centre of gravity of the uncracked 
section. 

 

• Cracked stiffness is calculated in case that (ct <= cr). The stiffness (EAII, EIy,II, EIz,II) will be 
calculated taking into account parameters from the calculation of the 1D element which is nearest 
to centre of gravity of the 2D element. The height of compression zone is calculated according to 
formula: 

xs =
Acc − Acc,Rib

beff

 

 
Where : 

Acc – compressive area of whole cross-section for cracked CSS 
Acc,RIB – compressive area of part of cross-section (rib cross-section) for cracked CSS 
beff – effective width of the slab for check 

ct - is maximum tensile strength calculated for final cross-section (rib cross-section + 
part of the slab) and for characteristic combination 

 
The stiffness is calculated to the transformed centre of gravity of the cracked section. 

 

• The average stiffness will be calculated from the cracked and the uncracked stiffness using the 
distribution coefficient , which is calculated from the stresses calculated for the whole cross-section 
of the 1D element which is nearest to centre of gravity of the 2D element. 

 

bending stiffness around y-axis (EIy) = 1/[/(EIy)II + (1-)/ (EIy)I] 

bending stiffness around z-axis (EIz) = 1/[/(EIz)II + (1-)/ (EIz)I] 

axial stiffness (EA) = 1/[(/(EA)II + (1-)/( EA)I] 
 
 

 Orthotropy 

 
 
In engineering practice, you may often come across a situation when the slab (or wall) to be designed has 
different characteristics (stiffness) in the longitudinal and transverse direction and thus, shows different 

https://help.scia.net/webhelplatest/en/val/concrete15/codedependentdeflection/images/stiffness_rib_1d.jpg
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behaviour in these two directions. Such a behaviour may result from the geometry (e.g. ribbed slabs) or from 
physical assumptions for a particular situation, for example, when determining deformations in a cracked plate 
or when excluding vertical members from a horizontal stiffening system (e.g. masonry walls). 
 
Whenever you need to adjust the finite element model accordingly to reflect such a behaviour in SCIA 
Engineer, the orthotropic properties can be used. These orthotropic properties can be defined in two ways. 
 
 

Orthotropy in the properties of a 2D member 
 

 
 
 
Property modifier 

 

 
 
 
The difference is in the data you need to enter. In the orthotropy, the stiffnesses are defined directly, while in 
the property modifier, a factor is specified by which the isotropic stiffnesses are multiplied. 
The property modifier is a bit more flexible because it does not depend directly on the properties of the modified 
part. If you want to enter an uniaxially stretched plate, then you can do that for a 20cm thick plate and also for 
a 30cm thick plate using the same values. The orthotropic properties require that you define separate 
properties for each of the plates (20cm and 30cm one). 
 

On the other hand, also the orthotropy has its advantages. It can be parameterized, and the program includes 

a set of generators to help you with the input. 
However, it is important to understand individual orthotropic parameters. The stiffnesses are defined with 
parameters starting with a "D" or "d". The property modifiers ask for the following parameters for a shell 
element: 
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The parameters beginning with "D" represent plate stiffnesses. The parameters starting with "d" are membrane 
stiffnesses. 
 
The direction is derived from the direction of the local coordinate system. 
 
D11: Flexural stiffness in the "x" direction (bending) 
D22: Flexural stiffness in the "y" direction 
D12: Mixed stiffness of D11 and D22 (transverse contraction) 
D33: Torsional stiffness 
D44: Shear flexural stiffness in the "x" direction 
D55: Shear flexural stiffness in the "y" direction 
d11: Normal membrane stiffness in the "x" direction (stretching) 
d22: Normal membrane stiffness in the "y" direction 
d12: Mixed stiffness of "d11" and "d22" (transversal contraction) 
d33: Shear membrane stiffness 
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In case of a simple, isotropic plate, the stiffness can be expressed using the following formulas: 
 
 

Plate direction Membrane stiffness 

 

 

 

 

 

 

 

 
 
 
 

 How to model a one-way slab in SCIA Engineer 
 
 
A one-way slab is a slab that bears the load in one direction mainly. It can be a slab supported on two edges 
only or a slab supported on four edges for which the bigger span length Ly is at least twice the smaller span 
Lx. The design of a one-way slab will lead to reinforcement mainly in the bearing direction.  
In a Finite Element software like SCIA Engineer, when the slab is supported on its four edges, the software 
will by default consider it as a two-way slab. Since there is no predefined main direction for the bearing of the 

https://www.scia.net/sites/default/files/tt_orthotropy_1.jpg
https://www.scia.net/sites/default/files/tt_formulas_plate-stiffness.jpg
https://www.scia.net/sites/default/files/tt_formulas_membrane-stiffness.jpg
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load, the bending stiffness of the slab will participate in both x and y directions. In SCIA Engineer the user can 
easily define a one-way-bearing slab.  
 

 

 

 
Figure 1: Bending moments in a two-way slab (on the left) and one-way slab (on the right) 

 
 
In SCIA Engineer, the input of a one-way slab can be done with orthotropy properties. Two types can be used 
and are explained below. 
 
 
 

 One-way slab using “two heights” orthotropy type 
 
The example is made of a slab supported by beams and columns. In the slab properties, change the FEM 
model to “Orthotropy”, edit the orthotropy property and select the type of orthotropy “two heights”. The input 
data are the thickness of the plate for the calculation of the flexural stiffness in the x-direction, h1, and the y-
direction, h2. For a slab bearing mainly in the x direction (smaller span length in the example), h1 should be 
kept equal to the actual plate thickness (180 mm) and h2 (thickness in y-direction) should be reduced. 
 
 

https://www.scia.net/sites/default/files/tt_onewayslab_1.jpg
https://www.scia.net/sites/default/files/tt_onewayslab_2.jpg
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Figure 2: Parameters for a one-way slab using "two heights" orthotropy type 

 
 
There is no specific rule regarding the value of h2. With smaller values of h2, the results will be close to the 
following load distribution: 
 

 
Figure 3: Bending moment in the supporting beams of a one-way slab (on the left) and of a one-way load panel (on the right) 

 
 
The resulting moment mx in the slab is then close to a 1m-wide simply supported beam: 
 

mx =
q ∗ Lx

2

8
=

3 ∗ 5²

8
= 9,4kNm/ml 

 

https://www.scia.net/sites/default/files/tt_onewayslab_4.jpg
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Figure 4: bending moment mx in a one-way slab 

  
 
 

 One-way slab using “one direction” orthotropy type 
 
This type of orthotropy requires three input parameters and can also be used for modelling hollow core slabs: 
the equivalent beam cross-section CSS, the spacing L used for the calculation of the flexural bending stiffness 
in direction 1 (or x) and the concrete topping height h used for the calculation of the flexural bending stiffness 
in direction 2 (or y). To model a one-way slab, a small value of h can be used. However, keep in mind, that h 
is also used for the calculation of the self-weight of the slab. 
 
For the equivalent cross-section, a slab-equivalent shape is used: “thickness of the slab” x “width of the beam”, 
i.e. 180 x 1000mm. For the spacing parameter, as the slab is plain, the same value as for the width of the 
beam is used, i.e. 1000mm.  
 

 
Figure 5: Parameters for a one-way slab using "one direction" orthotropy type 

 

https://www.scia.net/sites/default/files/tt_onewayslab_5.jpg
https://www.scia.net/sites/default/files/tt_onewayslab_5ok.jpg
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Figure 6: Bending moment in the supporting beams and in the one way slab using the type "one direction" 
 
 
For small values of h2 or h, both types give the same results for the bending moment in the bearing direction 
and the load transferred to the supported beams. 
There are still some differences between both orthotropy types. First, using “one direction” type leads to higher 
values of bending moment on the secondary beams (parallel to the bearing direction). This is due to the 
torsional moment component of the plate (D33) that is different between both types. Secondly, with “one 
direction” orthotropy type, the self-weight of the slab is calculated based on the concrete topping thickness h 
only. The total height of the slab is thus not accounted for and the user has to add the missing part of the self-
weight manually in a permanent load case.  
 

https://www.scia.net/sites/default/files/tt_onewayslab_7.jpg

